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elaGMS Series GeoSIG Recorders

Disclaimer

GeoSIG Ltd reserves the right to change the information contained in this document

without notice. While the information contained herein is assumed to be accurate,

GeoSIG Ltd assumes no responsibility for any errors or omissions.

Copyright Notice

No part of this document may be reproduced without the prior written consent of GeoSIG

Ltd. Software described in this document is furnished under a license and may only be

used or copied in accordance with the terms of such a license.

Trademark

All brand and product names mentioned are trademarks or registered trademarks of



their respective holders.

All rights reserved.

GeoSIG Ltd

Switzerland

Applicability of This Manual

GMSela Instruments are constantly being improved. Although the manual you receive

along with your instrument corresponds to the actual software versions, you are advised

to check www.geosig.com periodically for the most recent version of this document, and

especially after performing any software upgrades. This manual is based on the

following software and firmware versions:

Compone

nt
Description

Required version or hi

gher

GeoDAS
Data acquisition and analysis software on the

computer
2.40

armdas Data acquisition software of the instrument 28.01.09

SUP Power supervisor 90.01.06

DSP Digital signal processor 128.05.01

Web

Interface
Web Interface 1.14

Linux OS Kernel Version 4.9.52

Warnings and Safety

 STATIC ELECTRICITY

The instrument and its sensor unit (if available) contain CMOS devices, and when

serviced care must be taken to prevent damage due to static electricity. This is very

important to ensure long-term reliability of the unit. Such risk exists when both the

housing lid and the internal panel are removed.

http://www.geosig.com


 INSTALLATION SITE

This instrument is designed for highly specialized applications. If installed in publicly

accessible areas it is the responsibility of the instrument owner to ensure that the device

is installed in a safe and secure manner.

The instrument should be installed in a well ventilated place and when possible be

protected from direct sunlight and heat.

The housing provides no protection against explosive atmosphere. The instrument must

not be operated without necessary protective measures (e.g. EX-proof housing) in an

area where explosive gases could be present.

 CLEANING

Disconnect the power from the instrument prior to cleaning. Do not remove the housing

lid during cleaning. Wipe all exterior surfaces with a damp cloth. Use mild detergent if

required. No water should be used if cleaning inside the instrument is required.

GeoSIG Cybersecurity Recommendations

GeoSIG instruments, as described in their documentation, have built-in security and

safety features against unauthorised access or use. However, ultimately it is the user’s

responsibility to ensure the safe and secure usage of our instruments based on their

actual implementation. No factory delivered solution can fit each and every possible

scenario. The user is advised herein that once you connect a device to a network, you

are also connecting that network to that device. It is the responsibility of the user to take 

ppropriate precautions so that all devices should be adequately hardened, such as with

individual strong passwords, and should have their traffic monitored and managed via

appropriate security features, such as firewalls. Also, non-critical devices should be

segmented away from networks that contain sensitive information.

Compliance with a well-defined security procedure helps protect not only an individual

device, but also other devices connected through the network. Such procedure would be

intended to prevent exploitation of an individual device’s resources by unauthorized

individuals, including the use of such device to attack other systems on the network or

the Internet.

The following recommendations can be considered in establishing such a security

procedure:

1. Physical access restriction



All devices must be restricted from unauthorised physical access and a well-defined

physical access procedure shall be utilised.

2. No Unattended Console Sessions

Except for the devices which are physically secured, no unattended console sessions

shall be left running.

3. No Unattended Network Sessions

No unattended user interface sessions shall be left running towards any device

accessed through its network interface.

4. Use of a Firewall

For a network that has any connection to the outside world, a hardware firewall must

be running and configured to block all inbound traffic that is not explicitly required for

the intended use of the network and the connected devices. The user can also

consider limiting outbound traffic.

 Any communication ports that are required for the operation must be protected.

5. No Unnecessary Services or Ports

If a service or port is not necessary for the intended purpose or operation of the

device, that service must not be running and the port must be closed. (e.g. if seedlink

server is running, but not used, turn it off)

6. Use of authentication

Network and console device access must require authentication by means of strong

and individualised passwords per device (no passe-partout passwords).

Wireless access must require strong encryption to associate (such as WPA2), or

some other strong mechanism to keep casual users near the access point from using

it to get full access to the network.

WEP or MAC address restrictions do not meet this requirement.

7. Password complexity and security

When passwords are used, they must meet the specifications similar to below:

 All default passwords must be changed at time of initial access or latest at

deployment into service.

Passwords MUST: contain eight characters or more contain characters from AT

LEAST two of the following three character classes:

Alphabetic (e.g., a-z, A-Z)

Numeric (i.e. 0-9)

Punctuation and other characters (e.g., !@#$%^&*()_+|~-=\‘{}[]:”;’<>?,./)



8. Privileged Accounts

Privileged and super-user accounts (Administrator, root, etc.) must not be used for

non-administrator activities. A secure mechanism to escalate privileges with a

standard account is acceptable to meet this requirement. Network services must run

under accounts assigned the minimum necessary privileges.

9. No Unencrypted Authentication

All network-based authentication must be strongly encrypted. In particular, insecure

services such as Telnet, FTP, SNMP, POP, and IMAP must not be used or must be

replaced by their encrypted equivalents.

10. Software / Firmware updates

Networked devices must only run software/firmware that are updated according to

supplier’s guidelines. A periodical check of any available updates from the supplier

must be sought.

Please contact GeoSIG Ltd if you require any further advice or clarification.

Symbols and Abbreviations

ADC Analog to Digital Converter

ARM Main proosssor

armdas GeoSG data acquisition software

Bootloader First program executed when unit starts

CF Compact Flash, memory card using Flash memory

Compact Flas

h
See CF

OSP Digital Signal Processor in charge of controlling the ADCS

GSIAFW GeoSG data acquisition software

EEW Earthquake Early Warning



Flash

 Program storage memory device. It contains the Linux lile system in 

Road On mode and some block amas under direct control of main

program or bootloader

FTP File Transler Protocol

GPS Global Positioning System

GUI Graphical User Interface

IMAP Internet Message Access Protocol

LAN
Local Ares Network, a simple branch nch of private network using pri

vate IP address. It could have or not have access to Internet (WAN)

NTP Network Time Protocol

POP Post Office Protocol

PPS Pulse Per Second

RAM Random Access Memory

RTC Real Time Clook

SD Secure Digital Memory Card

SNMP Simple Network Management Protocol

SPS Samples Per Second

SSH Secure Shell

SSID Service Set Identifier. This is the dereifier name of a wireless network

STP Shielded Twisted Pair

SUP Supervisor in charge of controlling the power management.

Telnet Teletype network



USB Universal Serial Bus

UTP Unshielded Twisted Pair

VPN Virtual Private Network

WAN

Wide Area Network. It is a network connection established between 2

LAN or a LAN and a server over the internet (usual case) or through 

a rented link.

WRA

Wi-Fi Protected Access. It is a secure specification that allows users t

o access information instantly wireless It is a more modern and secur

e link than the WEP type

WEP Wined Equivalent Privacy

Important information related to the current section

Caution. Reler to the instructions next to the marking, or refer to the r

elevant section of this user manual

Direct cument. This symbol indicates a direct current (DC) power line 

derived from an alternating current (AC) power source

Earth terminal

CE. This symbol indicates that the device conforms to all legal require

ments needed to achieve free movement and sale of the product thro

ugh the European Economic Area (EEA),

Introduction

Dear Valued GeoSIG Customer, thank you for purchasing this product.

These instruments have been optimised to meet the requirements of the majority of

customers out of the box and may have even been delivered tailored to your needs. In

any case, to be able to get the most out of our product, please carefully study this

manual, its appendices and referenced manuals, as well as any other documents

delivered with it.



This is a reliable and easy-to-use device, and at the same time a sophisticated product

that requires care, attention and know-how in configuring, installing, operating and

maintaining.

GeoSIG continually improves and enhances capabilities of all products. There may be

several other connectivity, hardware or software options for the instrument, which are

not covered in this manual. Refer to separate documentation from GeoSIG about

available options or ask GeoSIG directly.

Incoming Inspection

All instruments are carefully inspected both electrically and mechanically before they

leave the factory. Please check if all received items correspond with the packing list and

your order confirmation. In case of discrepancy please contact GeoSIG or your local

representative immediately.

2.1Damage During Shipment

If requested at the time of order, all instruments can be insured prior to shipment. If you

receive a damaged shipment and shipping insurance was previously arranged you

should:

Report the damage to your shipper immediately

Inform GeoSIG or your local representative immediately

Keep all packaging and shipping documents

Insurance claims may be void if the above procedure is not followed.

2.2Warranty

GeoSIG Ltd (hereafter GeoSIG) warrants hardware and software products against

defects in materials, workmanship and design for the defined period in the relevant

contract or offer, starting from date of shipment and 5 years parts and maintenance

support commitment. If GeoSIG receives notice of such defects during the warranty

period, GeoSIG shall at its option either repair (at factory) or replace free of charge

hardware and software products that prove to be defective. If GeoSIG is unable—within

a reasonable time—to repair or replace any cabinet to a condition as warranted, buyer

shall be entitled to a refund of the purchase price upon return of the cabinet to GeoSIG.

50% of freight charges on shipments of warranty repairs or replacements will be borne

by GeoSIG (normally one way freight).



2.2.1Limitation of Warranty

The foregoing guarantee shall not apply to defects resulting from:

Improper or inadequate maintenance by buyer

Buyer supplied software or interfacing

Unauthorised modification or misuse

Operation and storage outside of the environmental specifications of the instrument

Related to consumables or batteries

Improper preparation and installation at site.

Description

3.1Housing

The compact and robust design allows GMSela to be used as part of a large deployment

for EEW, as well as giving the ability to stream real-time data and record with multiple

filtering options and embedded adjustable triggering algorithms. It is an asset in damage

estimation and disaster management.

GMSela monitors ground motion in three orthogonal axes. It is a compact and robust

instrument, designed for large scale deployment for indoor and outdoor installation.

This instrument can be floor or wall mounted, see chapter4.

3.2 Connectors

The instrument has up to four connectors on bottom cover and two antenna plugs on top

cover:



3.2.1Standard External Connectors

These connectors always will be assembled:

POWER Connection to the power supply module of the instrument or to an external

battery.

ETH PoE Connection with Ethernet cable to a LAN. The cable connection is dominant

over the WiFi link. As soon as the cable connector is plugged in the instrument

ETHERNET socket, the Wi-Fi module will be turned off, even if the RJ45 connector at

the end of the cable is not plugged into any socket.

CONSOLE Connection to the console (Only for service or maintenance purpose)

3.2.2Optional External Antennas

ALARM Connection for external alarm.

Wi-Fi Antenna connector for wireless network.

GPS Antenna connector for optional internal GPS receiver.

3.3Visual Indicators

The instrument includes five LEDs to indicate information about its status. POWER,

SYSTEM, NETWORK, DATA and SENSOR LEDs are visible from outside.

Table1describes in detail the meaning of the LEDs activity.

LED LED state Instrument status

POWER Green solid Power is available from AC/DC power supply or from PoE



SYSTEM

White solid 

White flashi

ng Green fl

ashing Blue

flashing Yel

low flashing

Red flashin

g Red solid

Linux OS is starting up

Data acquisition software is starting up

Operational and synchronized to local time source(RTC) Op

erational and synchronized to external time source(NTP or 

GPS) Operational but a warning has been issued

Operational but an error has been detected

Instrument is not turning on because of high temperature. S

ee 9.1 Data acquisition software has stopped

NETWO

RK

Green solid

Blue flashin

g

Red solid

Network connection is available Data transmission in progre

ss

Network error

DATA

Green solid

Yellow flash

ing Blue sol

id

No events recorded in the memory An event is being record

ed

Events are recorded in the memory

SENSO

R

White flashi

ng Green s

olid Blue fla

shing Yello

w flashing 

Red flashin

g

Data acquisition is being configured Data acquisition is read

y

Data acquisition in progress

Non critical data acquisition problem occurred Critical data a

cquisition problem occurred

Table 1: Indicators description

3.4Power Supply

3.4.1Choice of Power Supply

The main power should be provided to the instrument from a 9 to 48 VDC supply. The

optional AC/DC power module provides 15 VDC at 1.2A unless otherwise specified. The

AC entry is compatible with 110 / 60 Hz or 230 / 50 Hz network without any adjustment.

The block has a C7 connector and can use any standard power cord with such



connector. The power module and the power cord supplied are both CE and UL

approved. The power module must be connected to AC with a 2-wire power cable

providing Phase and Neutral.

The following parts will be included in a shipment in addition to the instrument:

Ethernet cable, category 5 cable for 10/100 Mbit network with a suitable connector for

the instrument, 2 meters of cable and a standard RJ45 connector. Other cable lengths

are available by request.

Console cable for use on the external CONSOLE connector

3.4.2Optional Accessories

The following parts can be ordered additionally and will be added if specified at order

time:

External power supply module, 100 to 230 VAC / 50-60 Hz, CE and UL approved

External power supply cable with open-end leads

AC power cable, depending on the shipping address with European, US or Swiss

power plug

GPS time code receiver antenna with 5 meter cable, other cable length on request.

GPS is an option as the time can also be synchronised through the network using

NTP

Alarm card interface with open connector and open-end leads

Wi-Fi module and antenna

4G Modem module with antenna (excl. SIM card)

Any spare antennas

Installation

This section lists the procedures involved in installation of the instrument. The

procedures will be outlined as steps to be performed in the field or in-house prior to

deploying the instrument in the field.



4.1Site Selection

4.1.1Environmental Considerations

The choice of an installation site for a seismic event recorder is similar in most respects

to that of a regular continuous recording seismic station.

Although the instrument is housed in a solid, weatherproof case, it should be installed in

a place free from direct sunlight, precipitation, the danger of falling materials in the event

of a severe earthquake and the risk of tampering or vandalism if the unit is to be left

unattended.

There are also special considerations for event recorder installations. It is important to

select the site and set the trigger level to avoid unwanted data recording, such as

vibration from machinery, highway traffic, aircraft, waves, etc. It is wise to check the

instrument frequently during the first several days of operation after each set-up, to see

if there are previously unsuspected sources of noise which are triggering the instrument

and using up the memory.

You should make note at this point of any cultural or environmental sources of noise and

vibration around the selected site, which may cause false triggers of the recording

mechanism. These will have to be considered when setting the trigger parameters.

The operating temperature of the instrument itself is -20°C to +70°C. Nevertheless, if

any additional internal or external accessories/modules with lower operating temperature

ranges are used, the operating temperature of the combined system will be then limited

by the temperature characteristics of these accessories/modules.

4.1.2Power Supply Considerations

The instrument may be powered from a 115 / 230 VAC supply through an external

AC/DC converter which provides 9 to 48 VDC output, from an external battery, or

optionally from solar panels.

If the supply in the field will be from a 115 / 230 VAC supply, you need to connect the

VAC cable from the external AC/DC to the power source only. The instrument

operates continuously, providing a trickle charge to the internal battery, if supplied.

The VAC supply must consist of Phase and Neutral.

If the supply in the field will be from a 9 to 48 VDC supply, you need to connect the

power cable from instrument to the power source only.

It is highly recommended to check and configure the instrument for the correct time,

trigger and other relevant settings in the lab, prior to the installation (see chapter5). It



may then be carried to the remote site and then connected to the VAC power through

the external AC/DC converter or directly to the VDC power supply. After powered the

instrument starts automatically (see chapter9.1), the instrument runs with the pre-

configured parameters. This reduces the amount of time needed to configure in the

field – an important consideration in the case of an adverse condition.

4.1.3Communication Considerations

An Ethernet connection or Wi-Fi signal must be present to have data communication. If

the instrument uses an NTP Server as time source, please make sure that an internet

connection is available and the network settings are properly set in the instrument. If the

instrument is used as a stand-alone recording station, a notebook with an Ethernet

connector can be used for downloading the data on a regular basis. In a network the

stations will upload the data to the configured server.

4.2Installation

 For your convenience a training video explaining the installation of the instrument is

available at www.geosig.com→ Support→ ’How To …’ Videos

 Many times the locations of seismic equipment are highly exposed to electrical

disturbances caused by lightning or by the industrial environment. Although the

instrument contains over voltage protection, it may sometimes be necessary to use

additional surge protectors for the equipment. Contact GeoSIG or your local

representative for more information.

4.2.1Mounting the Instrument

4.2.1.1Space requirements for the installation

Minimum surface area requirements: 25 x 15 cm

4.2.1.2Direct mounting of the instrument

The instrument is designed to be directly installed on any flat surface like a structural

wall or the floor.

Drill six holes with 6 mm diameter in the concrete with a typical depth of 50 mm for the

supplied M4 screws (A) and anchor (B). If another model is used, please adapt the hole

dimensions accordingly. Clean the hole area of the dust. Insert the anchor into the hole.

If needed, use the provided washers to level the installation surface.

http://www.geosig.com


4.2.1.3Mounting the instrument with the base plate (Optional)

The unit must be fixed rigidly on the building foundation or structural wall; as option, a

base plate can be provided to level the instrument to the installation surface. The base

plate must be first fixed on the floor, ceiling or wall and then the instrument mounted on

it. For that purpose, the base plate has a central fixation hole (suitable for 8 mm screws)

and three leveling screws. Prepare the base plate:

Mount the three leveling screws (A).

Check that the four M4 threads for the instrument fixation are free from dust.

Place the base plate at the selected location. Verify that the surface is sufficiently flat

and vertical so that the three feet can level the plate. Be sure to leave enough space at

the front of the instrument for the connectors.

The sides of the instrument should typically not be closer than 100 mm (4 inches) from a

wall. Mark on the wall the location of the central hole in the plate. Remove the base

plate.

Drill an 11 mm hole in the concrete with a typical depth of 50 mm for the supplied M8

concrete anchor (C). If another model is used, please adapt the hole dimensions



accordingly. Clean the hole area of the dust. Insert the concrete anchor into the hole.

Mount the plate in place and insert the M8 fixation screw (B) in its hole.

Turn the plate so it is oriented according to requirement. Make a coarse leveling of the

plate (D). Start fixing the plate by tightening the M8 central screw (B). Check regularly

the plate orientation and level until the plate is rigidly fixed (D). Now the instrument can

be placed on the mounting plate using the six screws and washers to fix it.

4.2.2Orientation, Leveling and Calibration of the Sensor

The correct fixation of the device can be verified by pushing from all directions. If you

feel any movement, recheck the fixation.

The instrument itself can be mounted in any orientation desired. The acceleration sensor

is located inside the housing and there is no need to remove the top or bottom cover to

adjust the orientation.

Nevertheless for most applications it is important that the internal sensor is aligned

according to the require- ments. This can be done using the axes label on the wall of the

instrument. In case the axes shall be aligned according to the global coordinate system,

the Y-axis must point direction north. So X-axis corresponds then to East-West, Y-axis to

North-South and Z-axis to Up-Down.

The gravity offset compensation can be adjusted via software during start-up of the

instrument. By default the instrument is set for wall mounting. To change the orientation

of the sensor, follow the instructions: •If the instrument is on and running, send the

command to reboot the instrument, otherwise switch on the instrument (See chapter9.1).

•Press ‘Ctr + Z’ as soon the following message appears on the console to enter the test

mode.

The following menu will appear (see chapter10for details):

By default no passwords are set, so press ‘W’ to enter the Powerful User Mode

Go to the sub-menu K – Instrument hardware parameters → D – Sensor parameters

→ L – Sensor orientation.

Choose the proper configuration according to the actual sensor orientation and



installation type.

4.2.3Installing other Components, Options, Accessories

For installation of other components options or accessories please refer to the specified

option manual.

4.3First Start and Communication Setup

With the instrument correctly fixed on the ground or on the wall through the fixation plate

please proceed with chapter5for the first start-up and configuration.

Quick Start Up

This chapter is intended to configure simple communication between the instrument and

GeoDAS software running on a Windows workstation, working as data server.

It is assumed that the GeoDAS software is already installed on a computer. If not, please

do the installation first with help of theGeoDAS User Manualbefore proceeding.

5.1Preparation

Make sure the instrument is powered by the provided power supply. The instrument

will start when power supply is applied. The POWER indicator should be solid green

when external power source is available

Make sure the instrument is connected to a LAN by the supplied Ethernet cable.

If provided, the internal battery is already plugged in at the time of shipment and it’s

not needed to open the device for connection.



 In case there is no LAN available, the Ethernet cable can be connected directly to a

computer. For this a crossed Ethernet cable is needed; please contact GeoSIG.

Nevertheless in modern computers normally it works as well with the supplied patch

cable.

In any case the instrument and the computer must be configured to have a fixed IP.

Please follow the procedure to adjust these settings.

Connect the instrument to a USB port of your computer by using a standard Mini USB

patch cable.

Open any terminal program and choose the appropriate COM port. Baud rate is

115200. Alternatively open GeoDAS, go to Tools → Terminal … and choose the COM

Port. As Baud rate select 115200. Then Press Connect

Keep the terminal open for the next step.

5.2 Set IP Address of the Instrument

Network settings of the instrument can be changed during startup of the instrument. By

default the instrument has a dynamic IP.

If the instrument is on and running, send the command to reboot the instrument,

otherwise switch on the instrument (See chapter9.1).

Press ‘Ctr + Z’ as soon the following message appears on the console to enter the

test mode.



The following menu will appear (see chapter10for details):

By default no passwords are set, so press ‘U’ to enter the User Mode, and then ‘N’ to

enter the menu Network settings.

Select ‘Y’ to change the settings and then select if the instrument should have a static

or a dynamic IP by pressing ‘1’ (Static) or ‘0’ (dynamic). In case a dynamic IP is

chosen, a DHCP server must be available in the network to provide the IP settings.

In case a static IP is selected, an additional message will appear asking for the

instrument IP address, instrument network mask and instrument gateway IP. If you

don’t know these parameters please ask your network administrator.

If the instrument has a Wi-Fi module, a second interface menu appears. Here static or

dynamic IP can be chosen and the available Wi-Fi networks can be scanned. Please

see chapter7.4for details.

If the instrument is connected to the Internet via a PPP connection (cellular or analog

modem), then the APN and password must be configured. See chapter7.4for details.

The instrument allows access to the operating system from remote over SSH. This

feature is not needed for normal operation of the instrument and can be disabled in

case of security concerns. By default it is enabled; to disable press ‘1’.

It’s highly recommended to put a recovery server IP address and recovery server

port. The instrument will contact this server every Recovery server contact interval in

case the connection to the main data server (configured in the configuration of the



instrument) is not possible anymore. This could happen, for example, if a configuration

file with wrong server settings were accidentally uploaded to an instrument.

As soon the following menu appears, press ‘5’ to start the instrument.

Start GeoDAS (if not already done), to add the instrument in its configuration

5.3No Stations Configured at first Start Up

The following steps require GeoDAS version 2.24 or higher. If you have an older version

download the newest release from www.geosig.com → Support → Downloads

When GeoDAS is started for the first time, it will ask to add stations in its

configuration.

Click Yes

 If there are already stations configured in GeoDAS, this window will not appear.

Please press the wizard button in the GeoDAS menu

 An exported GeoDAS configuration is   in the USB stick that gets shipped with

the instrument

5.4Adding New Stations …

 Make sure the computer is connected to the same network as the instrument and in

the same IP range.

In the following window, select My instrument other than GSR is connected to the

http://www.geosig.com


local network and press Next >

Enter the Serial number of the instrument and press Login>. It is also possible to add

more than one station by entering only a fragment of the serial number which is similar

on all instruments. For example if there are the serial numbers 100210, 100211 and

100234. By entering ’1002’ all the stations will be added. By putting ’10021’ just the

stations 100210, 100211 will be added.

All the found stations will be listed, press Finish to add them to GeoDAS

5.5Configuration of Data Server

Proceed to the menu Settings → Configure Stations …

The following window will appear where all the instruments are listed in the area 1. To

add stations make a right click and choose Add Station to current configuration.

Please see chapterC.1for details.



Press the button Server… When the window below appears, enter the following data:

My server IP address IP of your computer

Server port Select a user defined port, use 3456 by default

In most cases you do not need to enter an IP address. It may only be needed if your

computer has several network cards, and you would like to communicate to

instruments connected only to one subnetwork. Otherwise you may leave the default

zero IP address 0.0.0.0 If you don’t know how to find out your IP address, follow these

steps:

– Click Start → Run → type cmd, then press OK

– Enter the command ‘ipconfig’, then your IP appears

Ethernet adapter Local Area Connection:

Connection-specific DNS Suffix . :

IP Address. . . . . . . . . . . . :192.168.10.107



Subnet Mask . . . . . . . . . . . : 255.255.255.0

Default Gateway . . . . . . . . . : 192.168.10.254

– Type exit

Write down the IP and port you have configured

Press OK two times to exit again to the main window of GeoDAS

5.6Basic Configuration of the Instrument

In the window Stations: General Information make a right click on the station name

and select Instrument Setup…

A window showing the Web Interface will appear.

To be able to adjust the configuration of the instrument it is required to authenticate

oneself to the device.

The default login credentials are: Username: admin, password: 123456. Then press

login

Go to Configuration → Communication Parameters.



Tick the flag Contact Remote Servers to configure a connection to a remote server.

Go to Server Parameters

Configure the Server IP address and press. The default Server port is 3456 and

should be kept.

Then press Save and Restart.

Under Protocol, select Custom and add the default Port : 3456.

Then press Apply and Restart.

After the instrument has restarted it is ready for operation and can be configured

according to chapters8 and9.



Principle of Operation of the Instrument

This chapter gives an overview of the normal operation of the instrument in a network or

as a standalone unit.

6.1Normal Operation

During normal operation the instruments are installed on sites and connected to a data

server over Ethernet or Internet. The instrument checks in a defined interval whether

there are any requests or firmware updates ready for pick up on the server. Additionally

– and if configured – the instrument uploads the ringbuffer files (from continuous

recording) and the state of health files to the data server.

6.2Behaviour on a Seismic Event

In the event of an earthquake with vibrations above the trigger threshold, the instrument

will record the event and immediately upload it to the data server (see Figure20). In case

some of the stations are too far away from the epicentre to trigger, the data can still be

collected from all instruments:

A data request will be placed on the server

All instruments will download the request during the next time checking the server

(see Figure21)



All instruments will create an event at the time listed inside the data request and

extract these data out of the ringbuffer data.

The extracted event file will be uploaded to the data server (see Figure21)

6.3Firmware and Configuration Upgrade

In case of a firmware upgrade, the new firmwares can be easily put on the server. All

instruments will recognise the new firmware during the next server checkup, download

and install it. See chapter11for details about the firmware upgrade. The same happens

also with new configurations. In case the option “Keep connection to the server” is

enabled under Server Parameters (see chapter9.8for details), then the instrument will

keep the channel open so that it is possible to configure the instrument via the Web



Interface without knowing the IP address of the instrument. See chapter8for details.

6.4Backup Server

It might be that the instrument is not able to contact the main data server anymore:

either because it is down or a wrong server has been configured. For example, this can

happen if a configuration file with wrong server settings is uploaded accidentally to an

instrument. In this case the instrument will contact the backup server that has been

configured in the test and configuration menu. Therefore the configuration of the backup

server is very important and should not be ignored. For more information how to set the

backup server see chapter 5.2.

Network Settings

The network configuration is the same whether using a wired network or wireless



network. The specific settings related to the wireless network configuration via the local

console are described in chapter7.4.

7.1Network Settings through the Web Interface

To open the Web Interface please do one of the following two steps:

In the window Stations: General Information of GeoDAS make a right click on the

station name and click on Instrument Setup… or

 Open your browser and enter the IP address of the instrument (see chapter7.5for

details) in the address bar of your browser.

To be able to adjust the configuration of the instrument it is required to authenticate

oneself to the device.

The default login credentials are: Username: admin, password: 123456

Go to the tab Configuration → Network Configuration. The following screen can be

seen (pictured below).

Adjust the wired Ethernet settings under eth0. In case the instrument has a second

wireless Wi-Fi interface, then additionally available Wi-Fi networks can be scanned or

all parameters can be manually adjusted.

Click Save Network Configuration to Device.

7.2Network Settings through GeoDAS



•Under Settings click on Configure Stations…, the following window appears:

Make a right click on the station name and choose Edit Network Settings of Instrument

Adjust all the network parameters in the following screen wherein the Primary Network

interface is the wired Ethernet, and Embedded Wi-Fi interface is the wireless network

interface.



7.3Wired Ethernet settings through the local Console

Please see chapter5.2for details.

7.4Wireless Settings through the local Console

Switch on the instrument by pressing and holding the POWER button for 2 seconds.

Press ‘Ctr + Z’ as soon the following message appears on the console to enter the

test mode.

The following menu will appear (see chapter10for details):

By default, no passwords are set, so press ‘U’ to enter the User Mode, and then ‘N’ to

enter the menu Network settings and proceed until the following menu appears:

Select if the instrument should have a static or a dynamic IP address by pressing ‘1’

(Static) or ‘0’ (Dynamic). If a dynamic IP address is chosen, a DHCP server must be

available in the network to provide the IP address settings.

If a static IP address is selected, an additional message will appear asking for the

Instrument IP address, Instrument network mask and Instrument gateway IP address.

If you don’t know these parameters please ask your network administrator.

By pressing ‘E’ the instrument scans the available networks and lists them. Choose

the network to connect by pressing the number next to the network SSID or press ‘C’

to configure the network settings manually.

If the network is encrypted, please enter the network key.

Adjust the other parameters concerning the SSH or recovery server if required.

When the instrument tries to connect to the network, this can take a while. Please be



patient until the following menu appears again:

Press ‘5’ to continue the boot process of the instrument.

7.5Get IP from Instrument

To get the IP from the instrument please press ‘I’ in the main menu to access the

System information menu.

Press ‘L’ to view the Network information

Please see the IPs of the wired Ethernet (eth0) and the wireless Ethernet (wlan0)

listed and marked here inred.



The Web Interface

The instrument can be configured over a Web Interface. To be able to use the Web

Interface, it is necessary that the following criteria are fulfilled:

The IP address of the device has to be known (see chapter7.5) or the flag Keep

connection to the server under Server Parameters (see chapter9.8for details) must be

enabled (set to Yes).

In case the flag Keep connection to the server is disabled, the port 80 of the device

has to be accessible, from the accessing computer. This usually means that the

instrument is in the same network as the accessing computer and no firewall

mechanism separates the two.

A current browser version has to be available on the accessing computer.

8.1Accessing the Web Interface

To access the instrument please follow one of the following two steps.

In the window Stations: General Information of GeoDAS make a right click on the

station name and click on Instrument Setup…, as can be seen previously in Figure14,

or

Open your browser and enter the IP-Address (e.g. 192.168.30.176) of the device in

the address bar of your browser.



To be able to adjust the configuration of the instrument or access its data, it is

required to authenticate oneself to the device. This can be done by entering a valid

username and corresponding password in the fields of the same name and pressing

the “login” button.

The default login credentials are:

• Username: admin

• Password: 123456

 The default password can be changed as described in the chapter8.3.4of this

manual.

The Web Interface can be disabled under Network settings in the Administrator mode of

the test and configuration menu. See chapter10for details.

8.2The Home Panel and the General Navigation

After the login process has ended, the screen shown in Figure30becomes visible. The

width of the Web Interface is optimised for a screen width of 1024 pixels. If the width of

the browser window is smaller than that, it might be necessary to scroll horizontally.

As can be seen in Figure30, each screen in the web interface is separated into three

sections:



1. The Navigation Bar: The navigation bar allows accessing all screens within the web

interface. The navigation bar is further separated into two parts. The top bar is the

primary navigation panel which is visible from all screens. The currently active tab is

marked white, while all other– inactive – tabs are blue.

By changing from one tab to another, the secondary navigation panel becomes active.

This secondary navigation tab allows to switch between the actual screens within a

primary navigation bar.

2.  The Content Section: This section will contain all information and configuration

options. Most interaction will take place in this part.

3. The Device State Summary: On the left side the Station Description and Serial

Number is displayed to identify the current instrument you are working on. On the right

side the device state summary describes the overall status of the instrument. The

states that are possible are listed in Table2. By clicking on the overall state,

information on the actual problems will be displayed. More detailed information on the

error states are provided in the menu item “State of Health” as described in

chapter8.4.

Symbo

l
Meaning Description

No errors or warnings re

- ported from the device.

As there seem to be no issues, no action is requi

red.

A warning is reported

from the device

There seems to be an issue in this module. Al- t

hough it seems not to be critical, it is

recommended to check why this warning is displ

ayed and take ac- tions to resolve it.

A error is reported from 

the device

An error has occurred and it is required to check

for the cause of the problem and resolve it in ord

er to avoid limited functionality.

8.3Device Configuration

The configuration screen of the Web Interface gives access to all configuration options,

the configuration management of the Data Acquisition Software as well as the Network



Configuration and the Web Interface itself.

Loading the configuration can take a few seconds. During this time at the right corner of

the browser Loading… is displayed. Please be patient till the screen shown in Figure31

appears.

8.3.1Data Acquisition Configuration

The Data Acquisition sub menu provides access to the data of the current configuration

of the data acquisition software. As depicted in Figure32, the content of this tab is

divided into two sections:

1. The Configuration Panel: This is main part of the armdas Configuration screen. Within

this part of the screen all the values of the configuration of the selected Configuration

Menu Item can be adjusted. Most options will provide a help button in the form of

white question mark on blue ground on the right part of this section. By clicking on it

information will be displayed over the option. Please note that the only way to restore

the original values of the fields after making changes to them is by using the “Load

from Device” Button in the Action Panel.

2. The Action Panel: This panel is providing the option to either reload the current

configuration from the device (to discard changes or load changes done by another

user) or to save the edited configuration to the device or to save the edited

configuration to the device and restart the data acquisition software.

Saving and restarting will interrupt the current recording for about 20 seconds. During

this time triggers will not be executed either. Please note that if the device is

configured to use a DHCP server, the address might change during the saving of the



configuration which will make the web interface inaccessible under the old address.

8.3.2Configuration Manager

As described in the previous chapter, the Data Acquition screen only allows configuring

the currently used configuration. The Configuration Manager screen described in this

chapter allows managing several configurations, changing the current configuration,

uploading a new configuration and so on. As depicted in Figure 33, the screen is divided

into three sections:

1. The Configuration List: This list contains all configurations currently available on the

main storage media. The Current Configuration is always listed here. This

configuration can be copied and downloaded but not renamed, removed or made the

current configuration (as it is already the current). As depicted in Figure33, these

options become available to other configurations stored on the device (in this example

after uploading a file to the device). When pressing Use as Current Configuration it will

store this configuration as the Current Configuration. The existing configuration will be

overwritten and the instrument restarted. Note that only the Current Configuration can

be edited in the Firmware screen. The other configuration files will remain untouched.

The Current Configuration can be saved in a file by pressing Copy.

2. User Default Panel: With the Reset To Default, the Current Configuration will be

overwritten by the user default (see command SETDEFCFG in the chapter9.12.1) and

the instrument will be restarted. The Current Configuration can be saved as the user

default by pressing the button Make Current



3. The Upload Panel: While the Configuration List allows downloading configurations

from the device by clicking on the name, this part of the screen provides the possibility

to upload a configuration to the web interface by selecting a configuration file and

using the Upload Configuration Button. As can be seen in Figure34, after a successful

upload a new file is shown in the Configuration List and the name of the newly

available configuration is written at the top of the list. (The name of new configuration

will be created from a random string followed by “_config.xml”). The configuration can

then be changed by clicking on Rename. Note that the upload panel might look

different depending on the browser in use.

To upload a file, click on Choose File and select the configuration file to upload.

In figure35, click on OK to finalize the upload.

The red circle in the figure36shows the configuration file which was uploaded.

8.3.3Network Configuration



8.3.3.1Wired Ethernet

The Network Configuration screen provides the possibility to change the network

configuration of all network interfaces of the instrument. For the standard instrument

only one network interface is available: the Ethernet interface, which is present in all

devices. (This interface is marked as “ETHERNET” in Figure ). This interface can be

configured in the section of the screen that is marked with the red number “1” in

Figure37. The top part of that framed, red section describes the current configuration of

the interface. The part below allows changing this configuration. The name of this

network interface is traditionally eth0.

8.3.3.2Wi-Fi Wireless Ethernet

Some devices contain an additional wireless interface. If this is the case, a second

configuration panel is shown in the Network Configuration screen as can be seen

Figure37(marked with the red number “2”). As with the default Ethernet interface the

section surrounded by the red frame is split in two parts, where the top part defines the

current settings and the bottom part provides the possibility to change the configuration.

Additionally to the standard network settings like IP Address, Netmask, Gateway and so

on, the actual wireless settings can be adjusted and open wireless networks scanned.

The name of this network interface is traditionally wlan0. 

8.3.4Web Interface Configuration

The Web Interface Configuration screen allows configuring all settings related to the



Web Interface. At the moment, this solely consists of the possibility of changing the

password for the login. To change the password press Change. The current password

has to be known.

The default login credentials are:

Username: admin

Password: 123456

8.4State of Health

The State of Health (SOH) menu item provides all information related to the error status

of the device as well as the status of the available hardware and software versions.

8.4.1Error Status

As depicted in Figure39, this screen provides basic information about the device (area 2)

as well as the error status for each module (area 3). The summary of this SOH

information is visible at the bottom of each page as the Device State Summary,

described in chapter8.2. Additionally it is possible to download the State of Health

information as a file in XML format and clear the errors (area 1).



The modules in area 3 can have one of the states defined in Table2.

8.4.2Recording Status

This screen provides all information on the recording and time synchronisation status of

the device. As depicted in Figure40, this screen contains information on the number of

events, the timing and synchronisation status of the device, as well as information about

the GPS quality and the GPS position of the instrument.

8.4.3Hardware Status

The Hardware Status provides such information as uptime, available disk space, the



device temperature and so on. Information about the available hardware options in the

instrument, such as Alarm Boards, Wi-Fi Modules and Modems can be found in the

section Hardware Configuration Status.

8.4.4Software Status

The Software Status screen contains information on the Software Versions.

The section Software Upgrade allows to download firmware directly through the Web

Interface.

Click on Choose File, select a firmware to upgrade and click on Upload Software.

8.4.5Maintenance

As shown in Figure43, the Maintenance screen manage the data file, start a trigger, get



SOH file and sending signal-related requests to the data acquisition software.

The Data Management section allows to manage the files and start a trigger

File deletion allows to user to delete all or a specific type of file.

Trigger by request and create a data file can start a trigger by click on Trigger Now.

The Status and information section allows to update or download the SOH file.

Request actual status of the system in a file allows to user to delete all or a specific

type of file. It sends a request to the instrument to execute seflcheck and update its

state of health. It may take a while to complete, and then you can download updated

information in a SOH file.

The Miscellaneous Requests section allows to do different tasks:

Synchronise instrument time with PC time: If your instrument does not have a GPS

and does not connect to NTP servers, you can set its time from your browser. The

method is not very precise.

Send a Test Pulse: By sending this request, a test pulse will be executed. The sensor

should then respond accordingly and thus provide information about its status.

Remove DC from Signal: By sending this request, a baseline correction will be applied

to the signal and therefore the DC will be removed. A DC on the signal can be caused

by e.g. a slight misalignment of the sensor.

Battery maintenance command: if your instruemnt has internal battery, you must

update this information every time when you replace it.

Send any command: Type any known command supported by firmware and press



Send.

If the Seismometer Control option is available, it is possible to control the mass from this

window as can be seen in Figure44. The following commands are supported:

Lock: Locks the seismometer.

Unlock: Unlocks the seismometer. After unlocking, the sensor automatically centres its

mass.

Center: Centring of the mass

During all controls, the field Current Mass Position shows current mass positions of the

channels East-West, North-South and Vertical in mV. Feedback about the progress and

status information can be found under Seismometer Control Output.

8.5Data Explorer

The Data Explorer provides the possibility to gather information on the files stored on the

SD or CF card. The file types are separated into three different file types:

Automatically Detected Events (Event- and Calibration files)

Manually Triggered Events and Request Data (Event- and Calibration files)

Status and Information (SOH- and Log-files)

Ringbuffers (Ringbuffer files)

With the menu at the top of the Data Explorer it is possible to switch between the file

types listed above. For each listed file, the information on its file size and the last

modification time are displayed. The files can be sorted according to the file name, size

or modification date. By clicking on the file name, the file can be downloaded.



8.6Help

The Help Menu provides help if there are any problems with the device or the Web

Interface.

8.6.1Online Help

On this screen, the current version of the GMSela User Manual can be downloaded from

the device. This manual contains additional information on the instrument, which is not

provided in the interface itself.

8.6.2Contact GeoSIG Service

This screen provides information on how to contact GeoSIG service in the case of

problems. The links provided on this screen will only work if access to the Internet is

available.

Detailed Configuration of the Instrument

9.1Switch ON and OFF the Instrument

The instrument operates as follows:



As soon as any power source is available, from the AC/DC power adapter or the PoE,

the instrument will automatically start.

The SYSTEM indicator changes to solid white indicating that the operating system is

starting up and then it is flashing white indicating that the data acquisition software is

starting up. See Table1for details about the LED indications.

To turn the instrument OFF properly and to avoid any undesired remote power-off, the

instrument service console must be used.

Connect the USB cable on the CONSOLE port of the device (See chapter3.2)

Open any terminal program and choose the appropriate COM port. Baud rate is

115200. Alternatively open GeoDAS, go to Tools → Terminal … and choose the COM

Port. As Baud rate select 115200.

Then Press Connect. Press enter and the main menu will be displayed.

Navigate the menu to U – Control requests → 8 – Halt the system for manual power

off

The instrument will be halted and shut down. After the following lines are printed on

the console, the power can be disconnected. If the user does not remove power within

20 minutes, the device will power on again.

9.2General Comments to the Configuration

All the configuration changes can be done either over the network by the Web Interface

and GeoDAS or on the instrument itself using a standard Mini USB patch cable on the

internal Micro USB connector and a terminal program.

9.2.1Change Configuration by the Web Interface

Open an Internet browser and enter the IP address of the device in the address bar of

your browser.

Login with the username: admin and the password: 123456 See chapter8for the full

explanation of the Web Interface.

9.2.2Change Configuration by GeoDAS



In the window Stations: General Information make a right click on the station name.

GeoDAS is opening the default Internet browser. The Web Interface of the instrument

will appear. See chapter8for the full explanation of the Web Interface.

9.2.3Changing Configuration by the Console

Connect the GMSela to a serial port of your computer and switch on the instrument if

not already done.

In GeoDAS go to Tools → Terminal… and choose your COM Port. As Baud rate select

115200. Then

Press Connect. Any terminal application of your choice can be used alternatively.

Press <Enter> the following menu appears:

To configure armdas, from GMSela console, press ‘C’ and <Enter>. If you are asked,

select to edit the current configuration, by pressing ‘C’ again.

Change the configuration as described in the following chapters

Press <Esc> to leave the configuration menu. If asked, select save as current

configuration, by press- ing ‘C’

9.2.4Explanation of the Structure in the Manual

As the parameters in the configuration sometimes depend on each other, not all



parameters are shown all the time. The configuration is also sorted in several sub-

menus. Therefore the menu is explained as following:

Parameter in the menu
Possible selections

or ’User selectable’
Explanation

Switch-Parameter
Possible selections

or ’User selectable’

Explanation: The follo

wing three lines depen

d on the selection and

are only visible if not s

et to ’No’

This Parameter is only visible 

if Switch-Parameter has been 

set to Yes

Possible selections

or ’User selectable’
Explanation

This Parameter is only visible 

if Switch-Parameter has been 

set to Yes

Possible selections

or ’User selectable’
Explanation

Submenu

, only visi

ble if Swit

ch- Para

meter has

been set t

o Yes

Parameter in the 

Submenu

Possible selections

or ’User selectable’
Explanation

Parameter in the 

Submenu

Possible selections

or ’User selectable’
Explanation

Subme

Parameter in the Subme

nu

Possible selections

or ’User selectable’ Explanation

Parameter in the Subme

nu

Possible selections

or ’User selectable’
Explanation



nu
Switch-Parameter in the 

Submenu

Possible selections

or ’User selectable’
Explanation

This Parameter is 

only visible if Swit

ch- arameter has 

been set to Yes

Possible selections

or ’User selectable’
Explanation

Table 3: Explanation table structure

9.3Configuration of the Channels

9.3.1In the Web Interface or by GeoDAS

In the field Configuration → Number of Channels the total number of channels must

be configured first.

Go to Configuration → Channel Parameters to edit the channel parameters. See

Table4for additional information.



9.3.2Via Local Serial Console

Press ‘E’ to select the number of channels. By default three channels are configured

as most sensors have three channels normally.

Press ‘I’ to get to the Channel Parameters menu to adjust the settings of the channels.

The following menu appears:

Each channel can be adjusted according to your wishes. To change the channels

press ‘+’ or ‘-’. The following parameters can be adjusted:

The source of the channel can be defined



Data source INT-ADC-Sxx-C

xx EXT-ADC-Sx

x-Cxx DATACH

AN DATAVSUM 

DATAVSU3

See chapter 9.3.4

Virtual channels

Vector sum of two channels Vector sum 

of three channels

Source channel na

me
User selectable

The source of the virtual channel can be

any other channel

Second source ch

annel
User selectable

In case of the vector sum a second or thi

rd source has to be selectedThird source chan

nel
User selectable

Channel name User selectable The channel name in the record is a co

mbination of the location code and chan

nel nameLocation code User selectable

Source data unit User selectable Data unit of the selected channel

LSB factor User selectable
LSB factor, depending on the connected

sensor. See chapter 9.3.3 for details.

Sampling rate, sps

20, 40, 50, 100, 

125,

200, 250, 500, 1

000,

2000*, 2500*, 50

00*

Sampling rate of the selected channel. A

dditional sampling rates can be derived 

by configuring a decimation factor in the 

decimation and peaks op- tion. (*) Not s

upported in all models.

Negative axis
Yes

No

Inversion of the axis is enabled

Inversion of the axis is disabled



Offset compensation
Yes

No

Compensation is enabled Compensation

is disabled

Detail behavior of the offset compensati

on can be configured as described in ch

apter 9.9.2

Maintain Ringbuffer
Yes

No

Permanent recording is enabled

Permanent recording is disabled

Decimation and peak

s Online Decimation

The data can be decimated, or just peaks can be stored

Decimation Pea

k Values

Average Values

Additional down sampling of the data

Peak values of the data within a certain i

nterval Average values of the data within

a certain interval

Decimation factor User selectable

The signal will be decimated by the sele

cted factor.

E.g. if the sample rate is 50 and the deci

mation factor 10, then the output sample

rate is 5 SPS. Be aware that no anti-alia

sing filtering is done prior to decimation!

Interval of calculati

on, sec
User selectable

The Peak or Average values of the signa

l within the time defined in the Interval of

averaging will be written into the ringbuff

er with the specified Output sampling int

erval in [seconds].

Interval of averaging should be equal or 

higher than the Output sampling interval.

Output sampling

interval, sec
User selectable

Table 4: Channel configuration menu structure

9.3.3LSB factor

This section defines the calculation of the LSB value for the GMSela that has to be

configured in the Channel Parameters.



The GMSela can be provided with 2 different full scale: ± 1g or ± 4g. The actual full

scale can’t be changed by the user and it is reported on the label attached on the

device. The instrument is shipped with the correct LSB value which is calibrated

according to the device full scale and it reported on the calibration test record.

The nominal values are reported on the following values:

± 1g instrument → LSB= 1.272120652626E-07 (g/count)

± 4g instrument → LSB= 5.079452472776E-07 (g/count)

9.3.4Channel Naming

The naming of the channels is organised as following: all internal sensors start with INT-

ADC, all external sensors with EXT-ADC.

xxx-ADC-Syy-Czz

xxx Source INT EXT
Internal Sensor Ex

ternal Sensor

yy Sensor
3ch: S01

6ch: S01,S02

zz Channel C01 . . . C03

For example if there are two external sensors connected, the following channels are

available:

EXT-ADC-S01-C01 EXT-ADC-S02-C01

EXT-ADC-S01-C02 EXT-ADC-S02-C02

EXT-ADC-S02-C03 EXT-ADC-S02-C03

9.4Configuration of Data Streams

9.4.1In the Web Interface or by GeoDAS

In the field Configuration → Number of Output Streams the total number of output

streams must be configured first so that the Stream Parameters menu appears.



Go to Configuration → Stream Parameters to edit the stream parameters. See Table5for

additional information.

9.4.2Via Local Serial Console

Press ‘F’ to select the Number of Output Streams. One output stream can have

several channels.



Press ‘J’ to get to the Stream Parameters menu to adjust the settings of the output

streams. The following menu appears:

Each output stream can be adjusted according to your wishes. To change the output

stream press ‘+’ or ‘-’. The following parameters can be adjusted:

‘+’ and ‘-’ can be used to change between the channels

Stream name
User selec

table
Name of the output stream

Stream type GSBU
Streaming possibly in GSBU format o

nly

Port confi

guration

Communication P

ort
TCP/IP Streaming over the network

Protocol
TCP(SERV

ER)

GeoDAS software or any other client 

supporting the selected protocol conn

ects to the IP address config- ured un

der ‘IP Address’ for data streaming

 

Network Port

User

selectable

Server port listening for incoming con

nections



Baud Rate

1200

2400

4800

9600

19200

38400

57600

115200

Baud rate of the serial data stream. M

ake sure that the serial port of the co

mputer is configured to the same bau

d rate.

Channels in the stream
User

selectable

Number of channels which should be 

streamed

List of str

eamed ch

annels

‘+’ and ‘-’ can be used to change the channels

Assigned channel

name

User

selectable

Depending on the number of channel

s, for every channel a different source

can be selected; the source can be s

elected by pressing ‘A’.

Data frames per packet
User

selectable

Specifies the packet length of the stre

ams (one data frame is equal to 200 

ms). For example if ‘5’ is se- lected, t

hen every second a packet with the la

st sec- ond of data will be sent.

CRC32 protected packets
Yes

No

Enable CRC32 protection for the stre

am

Disable CRC32 protection for the stre

am

Number of padding bytes
User

selectable

Add the specified number of padding 

bytes to the stream

Table 5: Data streaming configuration menu structure

9.4.3Set up of Data Streams

This chapter will describe how to set up an instrument for data streaming.



9.4.3.1In the Web Interface or by GeoDAS

Connect to the Web Interface and configure the number of the Data Streams in the

field Configuration → Number of Output Streams. One output stream can have several

channels.

Go to Configuration → Stream Parameters to adjust the settings of the output

streams.

9.4.3.2Via Local Serial Console

Connect to the instrument and press ‘F’ to select the Number of Output Streams. One

output stream can have several channels.

Press ‘J’ to get to the Stream Parameters menu to adjust the settings of the output

streams.

Adjust the settings according to chapter9.4. Carefully select the settings in the Port

Configuration. If you want to stream over Ethernet, choose TCP/IP and TCP (Server).

If you want to stream over the SERIAL port on the front of the instrument, choose

ttyS03.

Open GeoDAS and go to the menu Settings → Channels of Digitizers… The following

window appears:



Adjust the Name, choose any three-letter code for the data stream

Select as Type the GeoSIG Packet Digitizer

Press Add/Modify

Make sure the selected Sample rate is the same as in the instrument.

Choose either the Local COM port (if connected over RS-232) or the Remote host IP

address and port (if connected over Ethernet). The instrument’s IP address must be

known.

Check the flag Use channel parameters provided by the digitizer.

Press OK.

After a restart of GeoDAS, the window Stations: Data Streams appears:

To view the data make a right click on the station name (here TST00) and select Data

Monitor

9.5Trigger Settings

The instrument allows having several triggers with independent sources in parallel.

9.5.1In the Web Interface or by GeoDAS

Go to Configuration → Number of Trigger Sets and configure the number of the

desired Trigger Sets.



To edit a trigger go to Configuration → Trigger Parameters. See Table6for additional

information.

9.5.2Via Local Serial Console

Press ‘G’ to select the Number of Trigger Sets



Press ‘K’ to get to the Trigger Parameters menu to adjust the settings of the triggers.

The following menu appears. In case the number of trigger sets is set to ‘0’ this menu

can not be selected.

Each trigger set can be adjusted according to your wishes. To change the trigger set

press ‘+’ or ‘-’. The following parameters can be adjusted:

‘+’ and ‘-’ can be used to change between the channels

Triggerset name
User selecta

ble
Name of the trigger set

Trigger time frame, sec
User selecta

ble
See chapter 9.5.5 for details

Trigger source

Network vo

ting logic L

ocal trigger

s

Choose the trigger source



Support triggers through Intercon

nection

Yes

No

This recorder will broadcast 

a Network Trigger Alert (in c

ase the instrument is interco

n- nected over RS-485 with 

other instruments) as soon a

s this triggerset becomes act

ive. No trigger through interc

onnection

Serial numbers of networked instr

uments

User selecta

ble

Whitespace or comma separ

ated list of instruments which

contribute to the Network vot

ing logic.

Contribute to network triggers
User selecta

ble

If this option is active, this re

corder will broadcast a Netw

ork Trigger Alert

Monitored channels
User selecta

ble

Number of channels which w

ill be monitored by the select

ed trigger set

Count trigger votes by

Channels C

hannel wei

ght Sensor 

Station

Choose one trigger vote in th

is list

Minimum number of votes
User selecta

ble

Define the number of incomi

ng network triggers of the sa

me name that have to be ob-

served in order to make this 

device trigger

Assigned channel name
User selecta

ble

Configure the first Data Sour

ce for this channel.



Trigg

er ch

annel

settin

gs

Trigger filter
Yes

No

Trigger filter is used as defin

ed under Filter

Parameters

Trigger filter is not used

Filter para

meters

Filter type

Highpass

 

Lowpass B

andpass

A Highpass will attenuate all 

frequencies

below a defined frequency.

A Lowpass will attenuate all f

requencies above a defined f

requency.

A Bandpass will attenuate all

frequencies below a defined 

frequency and above a de- fi

ned frequency.

Filter order
User selecta

ble

Defines how much the atten

uation in- creases per decad

e below the Low Fre- quency

Corner respectively above th

e High Frequency Corner. Th

e attenuation in- creases by t

he filter order multiplied with 

20 dB. User can choose bet

ween these values: [2-4-6-8-

10-12]



Flow, Hz
User selecta

ble

The Low Frequency Corner 

of the filter is the point where

the attenuation is 3 dB. Be- l

ow this frequency, attenuatio

n will increase depending on

the Filter Type

Fhigh, Hz
User selecta

ble

The High Frequency Corner 

of the filter is the point where

the attenuation is 3 dB. Abov

e this frequency, attenuation 

will in- crease depending on 

the Filter Type

Tr

ig

g

er

c

h

a

n

n

el 

Level Trigger
Yes

No

Level trigger is enabledLevel trigg

er is disabled

Threshold

(channel units)

User

selectable

As soon the data is above the

configured threshold the trigger is 

activated

Min. level exceeda

nce,

sec

User

selectable

The threshold or STA/LTA ratio ha

s to be exceeded at least for the c

onfigured time in seconds to activ

e the trigger

STA/LTA Trigger
Yes

No

STA/LTA trigger is enabled

STA/LTA trigger is disabled

STA time frame, se

c

User

selectable

Length of STA time window, secon

ds

LTA time frame, se

c

User

selectable

Length of LTA time window, secon

ds



se

tti

n

g

s 

(c

o

nt

in

u

e

d)

STA/LTA trigger rat

io

User

selectable

As soon the data is above the

configured

STA/LTA ratio the trigger is activat

ed

STA/LTA detrigger 

ratio

User

selectable

As soon the data is below the conf

igured

STA/LTA ratio again the trigger is d

eacti- vated

Min. ratio

exceedance, sec

User

selectable

The threshold or STA/LTA ratio ha

s to be ex- ceeded at least for the 

configured time in seconds to activ

e the trigger

Clamp LTA during 

event

Yes

No

As soon the data is below the conf

igured

STA/LTA ratio again the trigger is d

eacti- vated

Channel trigger weight

, %

User

selectable
See chapter 9.5.4 for details

Event recording
Yes

No

An event file will be recorded on a 

trigger

No event file will be recorded on a 

trigger

Pre-event
User

selectable
Pre-Event time, seconds

Post-event
User

selectable
Post-Event time, seconds



Max. event duration, sec
User

selectable

Maximum duration of an event in s

econds.

After this time, an event file will be

closed

Event Processing

PGM parame

ters

No

An event file will be processed an

d a summary report will be create

d

The event file will not be processe

d

Stored channels
User

selectable

Number of channels, which should

be stored into an event file in case

of a trigger

Li

st

of

st

or

e

d 

c

h

a

n

n

el

s

‘+’ and ‘-’ can be used to change the channels

Assigned channel nam

e

User

selectable

Depending on the number of chan

nels, for every channel a different 

source can be selected; the sourc

e can be selected by pressing ‘A’.



Alarm activation

(Only visible in case alarm relay c

ard is installed)

Yes

No

An alarm relay will be activated o

n a trigger

No alarm relay will be activated o

n a trigger This option has an effe

ct only in case the instrument has

internal alarm relays

Alarm output to activate
AL1, AL2,

AL3*, AL4*

select the alarm output you want 

to activate

in case of a trigger. (*) Not availa

ble in all models

Alarm deactivation delay
User selectab

le

Time in seconds the alarm relay d

eactivates again after the signal f

alls below the trigger threshold. C

an be compared to the post

event time for the recording

Alarm acknowledge
User selectab

le

Digital input to acknowledge and 

reset the

alarm. See appendix A

Send SOH upon alarm activa

tion

Yes

No

Defines whether a SOH informati

on will be created and transferred

to the server upon alarm deactiva

tion

SMS Alarm
Yes

No

An SMS will be sent upon a trigg

er

No SMS will be sent upon a trigg

er



S

M

S 

Al

ar

m 

Co

nfi

gu

rat

ion

(This option is available only in case an external cellular modem is connected

to the instrument.)

Number of Recipients
User selectab

le

The number of recipients of the S

MS alarm can be selected

R

ec

ipi

en

t

‘+’ and ‘-’ can be used to change the channels

Recipient
User selectab

le

Phone number of the recipient. U

se numbers only, no ‘+’ or any ot

her character al- lowed. The recip

ient can be selected by pressing ’

A’.

Table 6: Trigger settings configuration menu structure

9.5.3STA/LTA trigger

The STA/LTA (Short Time Average/Long Time Average) ratio trigger computes the short

term and long term averages of the input (sensor) signal. When the STA exceeds a pre-

selected multiple of the LTA (STA/LTA ratio), the instrument begins to record data. The

advantage of this trigger type is that the trigger sensitivity adapts to the seismic

background signal. With an increasing noise level the trigger sensitivity decreases. The

probability of having a false trigger due to noise will be minimised if a long STA

averaging time is selected.

Obviously, the STA should not be chosen longer than the shortest event of interest. In

addition, the STA should be shorter than the pre-event time. If not, the initial portion of

an event may not be recorded. During the steady state of the system, the STA and the

LTA will be nearly equal. The shorter STA averaging period, the more uickly it will change

with the input.

9.5.4Trigger Weight

To activate a trigger the total trigger weight must be equal or bigger than 100%. By

default all channels have a weight of 100%, which means if a threshold is exceeded on

one channel only, then the trigger is activated.

If the trigger weight were reduced on all channels to 50%, then at least on two channels

the threshold would have to be exceeded to reach 100% (50%+ 50%) and activate the



trigger. See Figure58for details.

9.5.5Trigger Time Frame

Depending on the settings, it can be that threshold must be exceeded on two or more

channels to activate the trigger. The time of the threshold-exceedances might be slightly

different on the channels, especially if two sensors are connected and installed on

different places. To make sure that even due to this time difference the trigger is working

a trigger time frame can be defined. See Figure58for details.

9.6Preset Trigger Settings

The instrument allows having several predefined triggers, e.g. time triggers in parallel.

9.6.1In the Web Interface or by GeoDAS

•In the field Configuration → Number of Preset Triggers the total number of the preset

triggers must be configured first so that the Parameters of Preset Triggers menu

appears.



•Go to Configuration → Parameters of Preset Triggers to adjust the parameters of the

preset triggers. See Table7for additional information.

9.6.2Via Local Serial Console

•Press ‘H’ to select the Number of Preset Triggers

Press ‘L’ to get to the Parameters of Preset Triggers menu to adjust the settings of the



preset triggers. The following menu appears only if the number of preset triggers is

higher than ‘0’.

Each trigger set can be adjusted according to your wishes. To change the preset

trigger set press ‘+’ or ‘-’. The following parameters can be adjusted:

‘+’ and ‘-’ can be used to change the preset triggers

Preset trigger name
User selectabl

e
Name of the preset trigger set

First trigger type

Manual Trigg

er

After Event A

fter Startup D

ate and Time 

Hardware Tri

gger

A trigger is activated/stopped by the user

command TRIGGERNOW/STOPTRIGG

ER sent either from the console or remot

ely from a server

A trigger is activated after recording of an

y event file First trigger is activated after t

he instrument startup First trigger is activ

ated at the defined date/time The trigger i

s activated by hardware

Duration, sec
User selectabl

e

The duration the scheduled trigger will be

active

Delay after event, s

ec

User selectabl

e

If After Event is selected, then the time b

etween the end of the event to the begin

ning of the activation of the preset trigger

can be configured

Pre-event, sec
User selectabl

e

If After Event is selected, duration of the 

pre-event

Post-event, sec
User selectabl

e

If After Event is selected, duration of the 

post-event



First trigger time, y

ear

User selectabl

e

Date and time of the first trigger

First trigger time, 

month

User selectabl

e

First trigger time, d

ay

User selectabl

e

First trigger time, h

our

User selectabl

e

First trigger time, 

minute

User selectabl

e

Total number of tri

ggers

User selectabl

e

After reaching the configured number of t

riggers the preset trigger will not be activ

ated anymore

Stored channels
User selectabl

e

Number of channels which should be stor

ed into an event file in case of a trigger

Li

st

of

st

or

e

d 

c

h

a

n

n

el

s

‘+’ and ‘-’ can be used to change the preset triggers

Assigned channel 

name

User selectabl

e

Depending on the number of stored chan

nels differ- ent sources can be selected. 

Select the source by pressing ‘A’.



Table 7: Preset trigger configuration menu structure

9.7File Storage and Policy

It can be configured in the instrument how all the files should be treated.

9.7.1In the Web Interface or by GeoDAS

Go to Configuration → File Storage and Policy

Parameters for the following file types can be configured (see Filetypes in Table8)

▪ SOH – State of health information and requested data files

▪ LOG – System log files

▪ TRG – Events and PGM files

▪ RBF – Ringbuffer files

▪ MAN – Scheduled manual recordings

▪ MSC – Miscellaneous files

See Table8for more information about the parameters which can be configured.

9.7.2Via Local Serial Console

To adjust the settings of the file storage, press ‘M’; the File Storage and Policy menu will



appear.

Parameters for the following file types can be configured (see Filetypes in Table8)

▪ SOH – State of health information and requested data files

▪ LOG – System log files

▪ TRG – Events and PGM files

▪ RBF – Ringbuffer files

▪ MAN – Scheduled manual recordings

▪ MSC – Miscellaneous files

See Table8for more information about the parameters which can be configured.

System reserved spac

e

User selectabl

e

Amount of memory reserved for the oper

ating system in [Mb]. Keep 12 Mb by defa

ult.

Length of one RB file
User selectabl

e

Permanent data will be stored in

ringbuffer files; here the length of one rin

gbuffer file in minutes can be specified. A

fter this time the file will be closed and a 

new one started.

Disk space qu

ota

User selectabl

e

Reserved memory on the SD/CF-Card fo

r the SOH files in [%]

If over quota
Delete oldest 

files

In case the reserved memory is full the ol

dest files will be deleted first

Life time
User selectabl

e

After the configured time in [days] the file

s will be deleted from the SD/CF-Card



Filety

pes
Transfer priori

ty

Never Transfe

r Low

Mid

High

Highest

In case a lot of files have to be transferre

d, the priority of the file upload can be co

nfigured here. If Never Transfer is configu

red, then no files will be uploaded.

Transfer order
Newest first

Oldest first

Most recent files are transferred first

Most old files are transferred first

Delete transfe

rred

 

Yes

No

Files will be deleted after upload to the s

erver

Files will be not deleted after upload to th

e server

Table 8: File Storage and Policies menu structure

Additionally the system log files can be compressed. This can be separately enabled

under the menu point D) System log files:

Compress files
Yes

No

Files will be sent gzip-compressed (.gz)

Original text files will be sent (default)

State of health and event files have two more configuration options:

Transfer protocol

Standard (Custo

m)

HTTPS

Default option. This protocol also is used to 

transfer any other types of files.

This option can be used to upload data files

to the HTTPS servers only. Downloads are 

not supported.

Directory for uplo

ads
User selectable

Name of the directory on the HTTPS server

where up- loaded files will be placed

9.8Communication Parameters

This chapter explains how to set up the server parameters.



9.8.1In the Web Interface or by GeoDAS

Go to Configuration → Communication Parameters

Tick the flag Contact remote servers to configure a connection to a remote server.

Configure the number of servers to contact in the field Number of servers

Then go to Server Parameters to adjust the parameters as shown in the Table9.

In case the instrument should act as Server for other GMS instruments, tick the flag

Server mode for other instruments and follow the steps as described in chapter9.8.2.1

9.8.2Via Local Serial Console



Press ‘N’ to get to the Communication Parameters menu to adjust the settings of the file

storage. The following menu appears:

The following parameters can be adjusted:

Contact remote servers
Yes

No

The instrument connects to the co

nfigured data server(s)

The instrument does not connect t

o any data servers

Number of servers
User select

able

Number of data servers. If the inst

rument cannot connect to the first 

data server it will connect to the s

econd data server; if this one is

down it con- nects to the third and

so on. Scanning of servers stops 

after first successful connection.

Time interval, sec
User select

able

Interval of connection to data serv

ers in seconds



Maximum files per session
User select

able

Maximum number of files, which 

will be uploaded during one sessi

on. Although data servers support

concurrent connections, this para

meter helps distributing the load o

f data processing by the server a

mong several instruments.

Connect if there are new files Yes No

Instrument connects to the server 

if there are new files recorded and

ready to be transmitted.

Instrument connects to the server 

if there are new files recorded and

ready to be transmitted. Instru- m

ent does not connect to the server

if there are new files. It just conne

cts periodically as defined with the

parameter Time interval.

Server IP Address
User select

able
IP address of the data server

Protocol
Custom H

TTPS

Default protocol of communication

This protocol can be selected only

if you upload SOH and/or EVT file

s to HTTPS servers

Port
User select

able

If Custom: Communication port of 

the data server

Transfer timeout, 

sec

User select

able

Instrument gives up trying to cont

act the server after the configured

timeout in seconds.



Server P

arameter

s

Network triggers
Yes

No

Triggers are sent to the server for 

event detection as described in ch

apter C.2

Triggers are not sent to the server

Connect through 

PPP link
Yes No

Instrument connects to the data th

rough PPP link

Instrument does not connect to th

e data server through PPP

Number of failure

s to give up

User select

able
Number of trials until giving up

Keep connected t

o the server

Yes

No

Instrument connects to the data th

rough PPP link

Server port for pe

rmanent links

User select

able

The port which should be used to 

keep the con- nection between th

e server open

Always connect t

o this server

Yes

No

Instrument will always try connecti

ng to this server, even if a file has 

already been delivered to another 

server Disable this function

Connect failures b

efore network err

or

User select

able

Number of failure before displays 

network error

Server mode for other instr

uments

Yes

No

The instrument acts as a data server fo

r other in- struments. See chapter 9.8.2

.1 for more details

The instrument does not act as a data 

server.



Connect by requests fro

m clients
Yes No

Instrument connects to the server if the

re are new files recorded and ready to 

be transmitted.

Instrument doesn’t connect to the serv

er if there are new files recorded and r

eady to be transmit- ted.

Port for incoming conne

ctions

User select

able

Port for incoming connections.

Other instruments have to set the sam

e port un- der Server parameters

Secure authentication
Yes

No

Secure authentication (SSL

encryption) enabled.

Secure authentication (SSL

encryption) disabled

Number of clients
User select

able

Number of clients that this server can u

sed

Cli

ent

s P

ara

me

ter

s

‘+’ and ‘-’ can be used to change between the servers

Client IP Address
User select

able

IP of the client instrument which conne

cts to this instrument.

Client serial numbe

r

User select

able

Serial number of the client instrument. 

Use 000000 to allow instruments with a

ny serial num- bers to connect.

Transfer timeout, s

ec

User select

able
Network timeout in seconds.

Data forwarding
Yes

No

Data from the data server will be forwa

rded to the client instruments and the o

ther way round.

Data will not be forwarded.



Network triggers
Yes

No

Triggers are sent to the server for even

t detection as described in chapter C.2

Triggers are not sent to the server

SeedLink server
Yes

No

SeedLink server is enabled for all data 

chan- nels, and data streams can be re

ceived by any SeedLink client from the

instrument’s IP.

The instrument does not act as a Seedl

ink server.

Accept connections
Yes

No

Allows GeoDAS to connect to the instr

ument. Works only if the IP address of 

the instrument is known and

reachable.

Do not accept connections from new cl

ients

Try next server on any

transfer error

Yes

No

If Yes, In case of communication error 

contact the next server out of the list of

Configured Servers.

Don’t try to contact the next server

Table 9: Communication Parameters menu structure

9.8.2.1Instrument acts in the Server Mode

The instrument can be configured to act as a server. In this case other instruments can

upload their files to this instrument. The server-instrument can then forward the data to a

main server by another communication medium. For example, two instruments (clients)

upload their files to the instrument-server, which forwards the data to a GeoDAS server

by the cellular modem.

The serial numbers and IP addresses of all client instruments must be configured in the

server so that requests from GeoDAS can be correctly forwarded.

 This setup is not recommended, as it creates a big load for the server instrument.

Special care must be taken during design and setup. Whenever possible, all instruments



shall have a direct communication path to the GeoDAS server.

Server mode
Yes

No

The instrument acts as a data server f

or other in- struments

The instrument does not act as a data

server

Port for incoming connec

tions

User select

able

Port for incoming connections. Other i

nstruments have to set the same port 

under Server parame- ters.

Secure authentication
Yes

No

Secure authentication (SSL

encryption) enabled

Secure authentication (SSL

encryption) disabled

Cli

ent

Pa

ra

me

ter

s

‘+’ and ‘-’ can be used to change between the clients

Client IP Address
User select

able

IP address of the client instrument whi

ch con- nects to this instrument

Client serial number Custom

Serial number of the client instrument.

Use 000000 to allow instruments with 

any serial num- bers to connect

Transfer timeout
User select

able
Network timeout in seconds

Data forwarding
Yes

No

Data from the data server will be forw

arded to the client instruments and

the other way round.

Data will not be forwarded



Network triggers
Yes

No

Network triggers will be sent to the

server

Network triggers will not be sent to

the server

Table 10: Server Parameters menu structure

9.9Miscellaneous Parameters

The Baseline Correction, State of Health files, messaging and debugging can be

adjusted under this menu.

9.9.1In the Web Interface or by GeoDAS

•Go to Configuration → Miscellaneous Parameters

Adjust the parameters as shown in the Table11.

9.9.2Via Local Serial Console



•Press ‘O’ to get to the Miscellaneous Parameters menu to adjust time synchronisation,

offset detection, and other settings. The following menu appears:

•The following parameters can be adjusted:

Offset detection time,

sec

User select

able

Time in seconds, which the input values i

s mea- sured after startup to define the of

fset. This ’static’ offset will then compens

ate all channels with acti- vated offset co

mpensation.

Offset correction time, se

c

User select

able

The instrument continuously takes the av

erage over the number of seconds specifi

ed. If this value is pos- itive it will subtract

the number of Offset Correction Counts d

efined below. If the value is negative, the 

Offset Correction Counts will be added to

the sig- nals. This is only active for chann

els where the off- set compensation is act

ivated and is used to com- pensate ’dyna

mic’ offset which changes over time (E.g.

because of temperature changes).



Offset correction counts
User select

able

The number of counts which will be adde

d to the sig- nal, respectively removed fro

m the signal, depend- ing on the signum 

of the continuously calculated av- erage o

ver the Offset Correction Time

MiniSEED record length
User select

able

Length of one data block inside the miniS

EED file. In most applications, the default

value 512 shall be kept.

Extended MiniSEED form

at

No

Yes (default

)

MiniSEED files do not include any additio

nal in- formation. This option shall be use

d only if you face any problems in readin

g extended format of miniSEED files with 

your customized software.

MiniSEED files include configuration and 

state of health information, which is enca

psulated into the blockettes 2000. When 

you open such files with GeoDAS, there i

s no need to enter LSB factors and units.

This feature is supported from GeoDAS v

er- sion 2.21.

Include SOH informati

onin miniSEED

Yes

No

(default)

Include SOH information in each MiniSE

ED file as Blockette 2000 record.

Do not include SOH information in each 

MiniSEED file as Blockette 2000 record.

Include configuration i

n miniSEED

Yes

No

(default)

Include current config.xml information in 

each MiniSEED file as Blockette 2000

record

Do not include current config.xml

information in each MiniSEED file as Bloc

kette 2000 record



Stat

e of

hea

lth

SOH report type
None Stan

dard

No SOH file will be created

SOH files will be created and uploaded t

o the server according to the settings in 

chapter 9.7

SOH reporting inter

val, days

User select

able

If Standard selected, defines the interval

between the SOH reports in days, hours

and minutes

SOH reporting inter

val, hours

User select

able

SOH reporting inter

val, minutes

User select

able

Time of the first S

OH report

Startup Ra

ndom User

defined

First SOH report will be created at start

up

Time of the first SOH is random. This is 

to avoid all instruments using the networ

k at the same time.

First SOH report will be created at the u

ser defined time.

First SOH

report time, hou

rs

User select

able
If User defined is selected, defines the h

our and minute of the first SOH reportFirst SOH

report time, min

utes

User select

able

Activate alarm on er

rors or Activate alar

m when system is in

active

Yes

No

Activates an alarm relay in case of an er

ror.

Alarm relay will not be activated in case 

of an error.



Yes

No

Alarm relay is activated in case armdas i

s not run- ning.

Alarm relay will not be activated.

Error and inactivity 

alarm output

AL1 AL2 A

L3

AL4

Select the alarm relay if at least one of t

he condition above is Yes

Activate alarm on e

rrors

Yes

No

Alarm relay is activated in case armd

as is not run- ning.

Alarm relay will not be activated.

Activate alarm on s

elected error only

Yes

No

Selected alarm relay is activated on s

elected errors only. See below option

s

Selected alarm relay is activated on a

ll errors.

Alarm on file- s

ystem errors

Yes

No

Enable the alarm of filesystem errors

Disable the alarm of filesystem errors

Alarm on mem

ory errors

Yes

No

Enable the alarm of memory errors

Disable the alarm of memory errors

Alarm on timin

g errors

Yes

No

Enable the alarm of timing errors

Disable the alarm of timing errors

Alarm on DSP 

errors

Yes

No

Enable the alarm of DSP errors

Disable the alarm of DSP errors

Alarm on netw

ork errors

Yes

No

Enable the alarm of network errors

Disable the alarm of network errors

Alarm on disk 

errors

Yes

No

Enable the alarm of disk errors

Disable the alarm of disk errors



State of 

health (

continue

d)

Alarm on aux e

rrors

Yes

No

Enable the alarm of aux errors

Disable the alarm of aux errors

Alarm on proce

ssing errors

Yes

No

Enable the alarm of processing error

s

Disable the alarm of processing error

s

Alarm on misc 

hardware error

s

Yes

No

Enable the alarm of misc hardware

errors

Disable the alarm of misc hardware e

rrors

Monitor state of cu

rrent loop sensors

Yes

No

It monitors the sensor offset for its val

id range. If sensor offset is outside of 

its valid range a sensor failure error 

message will be issued.

Disable the monitor state of the curre

nt loop sensor

Send SOH on chan

ging error state

Yes

No

Enable send SOH on changing error 

state.

Disable send SOH on changing error 

state

Send SOH on chan

gingwarning state

Yes

No

Enable send SOH on changing warni

ng state

Disable send SOH on changing warni

ng state

Type of periodic sens

or test

None Puls

e

No test pulse is generated

Test pulse is generated periodically and 

automati- cally, depending on the followi

ng settings



Te

st 

C

on

fig

ur

ati

on

Sensor test interva

l, days

User select

able
Interval between two sensor tests

Time of the first te

st

Startup Ra

ndom

User

defined

First test will be done at start-up, next af

ter the de- fined interval.

Time of the fist test is random. This is to

avoid, that all instruments in a network a

re doing the test in ex- actly the same m

oment and are not able to record events

normally at the same time.

First test will be done at the user define

d time.

First test report 

time, hours

User select

able If User defined is selected, defines the h

our and minute of the first test reportFirst test report 

time, minutes

User select

able

Activate alarms on

sensor test

Normal

Never Alwa

ys

An alarm is activated only if an amplitud

e of the test pulse is above the related t

hreshlold.

The alarms are not activated on tests A

n alarm is activated upon every test.

Record test files

Normal

Never Alwa

ys

A file is recorded only if an amplitude of 

the test pulse is above the trigger thresh

lold.

Test files are not recorded

A file is recorded upon every test.

Prefix for name

s of test files

CAL_

TRG_
Test files will be created with this prefix



Me

ss

agi

ng 

an

Console messages
Yes

No

Enable console message

Disable console message

Debug: memory allo

cation

Yes

No

Enable debug message: memory allocati

on

Disable debug message: memory allocat

ion

Debug: system and 

processes

Yes

No

Enable debug message: system and pro

cesses

Disable debug message: system and pro

cesses

Debug: flash memor

y

Yes

No

Enable debug message: flash memory

Disable debug message: flash memory

Debug: configuratio

n

Yes

No

Enable debug message: configuration

Disable debug message: configuration

Debug: network link

s

Yes

No

Enable debug message: network links

Disable debug message: network links

Debug: data streams
Yes

No

Enable debug message: data streams

Disable debug message: data streams

Debug: data sources
Yes

No

Enable debug message: data sources

Disable debug message: data sources

Debug: ring buffers
Yes

No

Enable debug message: ring buffers

Disable debug message: ring buffers

Debug: event trigger

s

Yes

No

Enable debug message: event triggers

Disable debug message: event triggers



d

de

bu

ggi

ng

Debug: time

synchronisation

Yes

No

Enable debug message: time synchronis

ation

Disable debug message: time

synchronisation

Debug: file manager
Yes

No

Enable debug message: file manager

Disable debug message: file manager

Debug: cryptographi

c info

Yes

No

Enable debug message: cryptographic in

fo

Disable debug message: cryptographic i

nfo

Debug: hardware rel

ated info

Yes

No

Enable debug message: hardware relate

d info

Disable debug message: hardware

related info

Debug: external har

dware

Yes

No

Enable debug message: external hardwa

re

Disable debug message: external hardw

are

Debug: JMA early w

arning

Yes

No

Enable debug message: JMA early

warning

Disable debug message: JMA early warn

ing



Ins

tru

me

nt 

co

nfi

gu

rat

ion

opt

ion

s

Enable

autodetection of the 

instrument

Yes

No

Instrument can automatically be found b

y GeoDAS in the LAN.

Instrument can not automatically be foun

d by Geo- DAS.

Time for sending daily log

file, hour

User select

able

If transfer is activated as described in ch

apter 8.7, the daily logfile will be sent to t

he server at this hour of the day. This ca

n be adjusted to avoid that all instrument

s send the logfile at exactly the same tim

e

Time for sending daily log

file, minute

User select

able

Keep modem always

powered

Yes

No

Keep the external cell modem always po

wered

Turning it on only when required

Startup time for cellular m

odem

User select

able

Time the system will wait for the Cellular

modem to start up

Connect time for cellular 

modem

User select

able

Time the system will wait for the Cellular

modem to connect to the provider



Si

gn

al 

pr

oc

es

si

ng

DSP mode set delay [

s]

User select

able

After startup, the instruments internal clo

ck is roughly synchronized against a fore

ign network time source (NTP) and time 

is pushed to the DSP. During this initial ti

me period the DSP will use this foreign ti

me to do sampling while synchronizing t

o an exter- nal time-source such as GPS

. After this initial time period the DSP will

be switch to the external time- source.

DSP sync behaviour
Dilate

Wrap

The DSP is supposed to drift against to 

correct time, i.e., an offset of the reporte

d and actual time is noted in each record

of the mini-seed file. No interrup- tions of

waveform processing occurs but it can ta

ke some hours until synchronization has 

been com- pleted. This mode is ideal for 

building monitoring.

Upon switchinhg the time-source, the D

SP stops waveform processing, re-synch

ronizes the ADC clocks and restarts wav

eform processing. This mode is only rec

ommended when long drift times are un

desirable.



DSP snap window 

[ms]

User select

able

Specifies the maximum allowed time diff

erence the DSP can drift to obtain synch

ronization with an ex- ternal time-source,

in case the instrument was run- ning for 

a long period of time on its internal RTC,

e.g., after GPS failure. If the time differe

nce be- tween the DSPs internal clock a

nd the external time source is larger than

the specified amount, the DSP will

perform a time-warp and waveform proc

essing will be restarted.

Waveform

processing style

Slow

Once per second waveform processing i

s executed which allows sampling rates 

as low as 1 SPS.

Standard

This is the default mode on all GeoSIG i

nstruments and supports sampling rates 

as low as 5 SPS.

Real-time

The scheduler guarantees an execution r

ate of 50 times per second for waveform

processing making this mode ideal for

applications in the early warning field.

Table 11: Miscellaneous Parameters menu structure

9.10Time synchronization

9.10.1In the Web Interface or by GeoDAS

•Go to Configuration → Time synchronization



Adjust the parameters as shown in the Table12.

9.10.2Via Local Serial Console

•Press ‘T’ to get to the Time synchronization menu to adjust the time synchronisation

parameters. The following menu appears:



Time source RTC

RTC is not synchronizing itself to any sourc

e. It will keep it’s own time which might diffe

r from other de- vices or the actual time.

GPS

RTC is synchronising to the, optionally, con

nected GPS, which allows very good time s

ynchronisation between devices with other 

GPS enabled devices.

NTP RTC is synchronising to a NTP server.

AUTO

RTC synchronises to NTP in case GPS is n

ot avail- able. This is a good option for GPS

and Ethernet enabled devices, where the G

PS reception might be lost from time to

time.

NET1PPS

RTC is synchronizing to the 1PPS signal. T

his sig- nal can be received by the optional 

433 MHz wire- less module or the interconn

ection network. (This option needs a device

which is broadcasting its time by 433 MHz.)

NTP server 1 User selecta

ble
IP of the primary NTP Server.



NTP server 2
User selecta

ble
IP of the secondary NTP Server.

NTP server query i

nterval, sec

User selecta

ble

Interval time in seconds the NTP server is c

ontacted by the instrument.

NTP requests in a r

ow

User selecta

ble

Every time the instrument is contacting the 

NTP server the configured number of reque

sts will be sent. For service and advanced 

user only, only change the default value if y

ou know what you are doing.

NTP query

intervals per RTC u

pdate

User selecta

ble

Specifies the number of NTP

synchronizations until the RTC is updated. 

The default is to update the RTC after each

synchronization with a NTP server.

NTP synchronisatio

n timeout warning, 

min

User selecta

ble

Raise a warning if synchronization with the 

NTP server was not possible for the given a

mount of time. Default is 240minutes.

NTP synchronisatio

n timeout error, ho

urs

User selecta

ble

Raise an error if synchronization with the N

TP server was not possible for the given a

mount of time. Default is 12hours.

NTP maximum erro

r, sec

User selecta

ble

If the current RTC time differs more than thi

s time limit in [seconds] from the NTP time, 

the RTC time will make a time jump to the 

NTP time. Otherwise the time will be tuned 

slowly. For service and ad- vanced user onl

y, only change the default value if you know

what you are doing



GPS reception time

out, min

User selecta

ble

If GPS signal is lost, after this time in [minut

es] the RTC will change its synchronisation 

method to NTP

GPS check interval 

in NTP mode, min

User selecta

ble

If the time synchronisation is in the ’Auto” m

ode, and the RTC is synchronized to the N

TP (because the GPS signal has been lost)

the instruments checks in the configured int

erval if the GPS is available again

(minutes)

GPS check interval 

in NTP mode, sec

User selecta

ble

If the time synchronisation is in the ’Auto” m

ode, and the RTC is synchronized to the N

TP (because the GPS signal has been lost)

the instruments checks for the configured ti

me duration if the GPS is avail- able again (

seconds))

RTC watchdog

timeout, sec

User selecta

ble

If armdas is not running for this amount of ti

me, there will be a hard reset of the device.

Only change this setting if you really know 

what you are doing! Wrong settings could r

ender your device unusable without GeoSI

G support. The value of 0 disables the Wat

chdog.

Send SOH upon RTC s

tatus change

Yes

 

No

In case RTC status changes, a SOH messa

ge will be uploaded to the server.

In case RTC status changes, no SOH will b

e send

Offset to UTC,

minutes

User selecta

ble

Difference between the local time and Coor

dinated Universal Time (UTC). The default i

s to use UTC as time reference.



Use IANA timezone m

apping

Yes

No

Use Time Zone to set instrument time

Don’t use Time Zone to set instrument time

Use ISO timestamp for

matting

Yes

No

Use ISO 8601 in all files name including off

set

Don’t use ISO 8601 in all files name includi

ng offset

Table 12: Time Synchronization Parameters Menu Structure

The system has a Real Time Clock (RTC) that maintains internal time when the unit is

turned off. During normal operation the RTC is responsible for providing the most

accurate time possible to the system and performing time synchronization with other

available external time sources as:

•GPS time code receiver on the GPS interface

•NTP (Network Time Protocol) server from the wired or wireless Ethernet interface

It also keeps under control the sampling clock of the ADCs and self-calibrates its

oscillator against temperature and aging when it is connected with an accurate external

time signal.

The DSP receives a continuous 1 PPS signal from the RTC with the best possible

accuracy of the RTC, including temperature compensation, based on the saved

coefficients. The DSP will sync the sampling clock with this 1 PPS signal to have

accurate sample timing.

9.10.2.1Temperature compensation

RTC uses the internal temperature sensor of the micro-controller to define the current

operating temperature.

When good time synchronization occurs, typically using a GPS, the RTC checks its own

drift against the signal of the GPS and adds the correction coefficients in a trim table.

With a NTP time source, the accuracy is worse but the same process occurs with more

averaging and on longer period of time.

During factory test, all the coefficients are initialized to the room temperature coefficient

using a GPS. After installation on site, the unit will learn the correction parameters

according to the ambient conditions at site and also according to the aging of the

oscillator.



9.11GeoSIG Options

This menu and the functions under it are subject to change. The user should not use or

rely on any features under this menu without consulting GeoSIG.

9.11.1Via Local Serial Console

•Press ‘S’ to get to the GeoSIG Options menu to enter Product key for EEW

applications, enable/disable and configure waveform injection and other GeoSIG specific

features.

•The following parameters can be adjusted:

Enable real-time

waveform message q

ueue

Yes

No

Enable the real-time waveform message qu

eue.

Disable the real-time waveform message

queue.

Product Key

(required for early wa

rning)

User selectab

le

If purchased, enter the product key for early

warn- ing options. The product key is of the 

form XXXXX- XXXXX-XXXXX-XXXXX-XXX

XX.

Wa

vef

or

m 

Si

Enable wavefor

m source

User selectab

le

Enable waveform inject from files (0…disabl

e, 1…first file, 2…second file, 3…third file.

Source 1 User selectab

le
Path for first waveform source.



mu

lat

or

Source 2
User selectab

le
Path for second waveform source.

Source 3
User selectab

le
Path for third waveform source.

Table 13: GeoSIG options menu structure

9.12Other Options in the Instrument Main Menu

Next to the edit of the instrument configuration, there are other actions possible from the

main menu shown below:

Action or command Description

C Configuration →
Change of the configuration of the instrument. 

See chapter 9 for details.

M Messages →
Possible to configure what kind of messages ar

e shown in the console.

X
Display errors (n) and warni

ngs (m)
Shows present errors and warnings.

W Clear errors and warnings Clears all errors and warnings.

T File statistics
Displays information about files and the

memory usage.

I System information →
Displays information about the status of the inst

rument.



S Shell command
Allows executing a Linux shell command from a

rmdas. For advanced users only.

U Control requests → See chapter 9.12.1 for details.

R Restart
Restarts the instrument, e.g. after a change of t

he configura- tion.

Z Restart Reboots the instrument.

Q Quit
Stops armdas data acquisition and exits to the 

Linux console. For advanced users only.

Table 14: Other options in the main menu

9.12.1Control Requests

Several actions can be initiated by the user:

•In the main menu press ‘U’ to enter the Control requests menu.

•Type the letter of the request you want to execute from the list below:



Lette

r
Request Description

Data requests, triggering:

A
GETEVT YYYY-MM-DD HH:MM

:SS N

The instrument creates an event with the le

ngth of N seconds from the ringbuffer data, 

starting from the indicated date and time an

d uploads the data to the server if configure

d (see chapter 9.8).

B TRIGGERNOW [trigger_name]

Activate a manual trigger to start recording, 

the manual trigger must be configured as d

escribed in the chapter 9.6

C STOPTRIGGER [trigger_name] Deactivates the manual trigger

Status and information:



D GETSOH

The instrument generates a SOH file with th

e cur- rent state-of-health information and u

ploads to the server if configured (see chap

ter 9.8).

E GETLOG
The instrument uploads today’s logfile to th

e server.

F SETMSG flags

CLRMSG flags

Enables/disables debug log messages. For 

service only, do not changeG

Service and recovery:

H
LASTDT YYYY-MM-DD HH:MM:

SS

Set date and time of the last transferred file

The instrument saves the date and time of t

he latest uploaded file and will not upload a

ny file which is created before this date and 

time. Under normal conditions this will be n

ever the case. But if the time is changed ba

ckwards by the user – e.g. from 10:00 to 06

:00 – the instrument will not upload any dat

a till 10:00 again. So the time of the last tra

nsferred file can be adjusted here and

should be set to 06:00 in this example.

I FORMAT

Formats the data storage media. All data w

ill be lost, and instrument will be restarte

d.

J REBOOT Performs full reboot of the instrument

K RESETERR
Reset errors and warnings of the

instrument



L GETTRIM

The instrument will upload a SOH file contai

n- ing the actual values from the RTC trim t

able. The latest SOH file can be found unde

r \\Geo- DAS_DATA\StatusFiles\InfoSOH.x

ml

M CLEARTRIM The instrument will clear the RTC trim table

N TCAL <Tcur>

Calibration of the internal temperature sens

or by ap- plying the actual temperature in °

C. The RTC uses temperature to learn.



O SETDEFCFG

Makes the current instrument configuration 

as user default one. Whenever you change 

parameters of the instrument, they are save

d in the non-volatile instrument memory as 

Current Configuration, and used to set all p

arameters of the data acquisition at startup.

But if due to some reason the current config

uration gets corrupted, and GMS cannot loa

d or cannot process it, the Default Configur

ation file, which is created by this

command, will be used in- stead. Note that 

Default Configuration is compiled from the a

ctual parameters of the running system, an

d therefore it is already approved by GMS a

nd is supposed to be correct. Thus, we

recommend send- ing this command to the 

instrument after you are sure that your GM

S is started with the latest config- uration co

rrectly and everything works as expected.

The default configuration can also be set

and re- stored in the Web Interface, see ch

apter 8.3.2

P RSTUSRDEF
Reset the instrument to its user default conf

igura- tion.

Q
DELETE <file_prefix or ALL> [Y

YYY- MM-DD [HH:MM]]

Delete one group of files or all groups of file

s from the compact flash card. One can req

uest to delete only files that are older than t

he specified date (and optionally time).



R

Enter the Date and time settings. The Main 

battery installation date and the current RT

C date and time can be changed from this s

ubmenu.

8 Halt the system

Halt the instrument for the manual device p

ower off

.

Sensor test and calibration:

V
TSTSENSOR 1 [REC=TRG|YE

S|NO] [ALARM=TRG|YES|NO]

The instrument generates a sensor test pul

se. Op- tional parameters REC and ALARM

specify whether a file will be recorded durin

g test and whether an alarm will be generat

ed in case an alarm board is present. Para

meters TRG, YES and NO correspond to th

e modes Normal, Always and Never describ

ed in the section 9.9.2

W REMOVEDC Remove offsets from signals

Direct request:

X For service and advanced user only.

Y For service and advanced user only.

Z For service and advanced user only.

Simulation and testing:

[ For service and advanced user only.

Table 15: Control requests

In case the instrument has a Seismometer Control Board installed, then additionally the



following user requests are possible under Sensor test and calibration:

SLOCK
Performs a mass locking of the connected seismome

ter

SUNLOCK
Performs a mass unlocking of the connected seismo

meter

SCENTRE Perform a mass centring of the seismometer

 The above requests can also be sent from GeoDAS by choosing ‘Send a Request’

from the ‘GMS Communication Interface’ or from Web Interface from the menu State of

Health → Requests . See chaptersC.3.4and8.4.5for details.

Test and Configuration Menu

The test and configuration menu can only be accessed locally at the instrument over the

serial cable.

Switch on the instrument by pressing and holding the POWER button for 2 seconds.

Press <Ctr> + ‘Z’ as soon as the following message appears on the console to enter

the test and configuration mode:

The test and configuration menu has three access levels.

The test and configuration menu has three access levels as outlined above: User,

Powerful User and Administrator, and each level can be protected by a password.

Instead of pressing <Ctrl>+‘Z’, one can press <Ctrl>+‘U’, <Ctrl>+‘W’ or <Ctrl>+‘A’ to

bypass the above messages and to proceed directly to a menu of the desired level. The

Administrator has access to the most complete menu but the majority of functions are

not used for the standard instrument operation, and therefore they are not described

here in detail. The useful options are highlighted and described below.



10.1Flash Images and Boot Options

L List flash images Lists all the current firmware in the image

Q

Reset instrument

configuration to the user

default

Forces the instrument to load the user default confi

guration. See description of the command SETDEF

CFG in the chapter 9.12.1

V

Reset instrument

configuration to the

factory default

Forces the instrument to load the factory default se

ttings

5
Boot from the default im

age

Exits the test and configuration menu and starts th

e instrument normally



X Reboot the instrument
Forces the watchdog to completely restart the instr

ument

Y Power off Forces the watchdog to switch off the instrument

10.2Hardware Setup and Monitor

K
Instrument hardware par

ameters

Checks what HW is installed in the instrument and 

adjust the number of sensors

N Network settings

Enters the menu to adjust the network settings (dy

namic or fixed IP, subnet and gateway, DNS server

s), the PPP settings, enable/disable the SSH and 

Web Interface and configure the backup server.

For details see chapter 5.2

T Battery installation dates
Whenever you install a new battery, you must set t

he installation dates using this menu.

10.3Test Functions

P Test RTC Runs an automatic check of the RTC

M Test GPS
Allows user to the see the NMEA messages of the 

GPS and to initialise the GPS receiver.

10.4Security

O Set password

Sets the password to prevent unauthorised access 

to the current level of the test and configuration me

nu.

J Reset all passwords Resets all passwords below the levels of access

•Leave the test and configuration menu by pressing ‘5’ or ‘Y’



10.5Comparison of User Permissions

User

Pow

erful 

User

Admi

nistra

tor

Flash Images and Boot Options

List Flash images X X X

Reset instrument configuration to the user default X X X

Reset instrument configuration to the factory default X X X

Boot now X X X

Reboot the instrument X X X

Power off X X X

Hardware Setup and Monitor

Instrument hardware parameters X X

Network settings X X X

Battery installation dates X X

Test Functions

Test RTC X

Test GPS X

Security

Set password X X X

Reset passwords X X



Table 16: Comparison of test and configuration menu users

Firmware Upgrade

All the firmware for

Linux operating system

armdas firmware

DSP

SUP

can be upgraded by the user by using GeoDAS as described in the following chapters.

The firmware will be released only as a complete package, containing all the firmware

listed above. Please see www.geosig.com→ Support → Downloads to download the

latest firmware release package.

 Even if there is no known case of data loss during the upgrade, we recommend

backing up all

recorded data and the configuration before starting the upgrade.

 After any firmware upgrade, the configuration and the correct function of the

instrument should be fully verified.

If the instruments are configured to contact a server, it is possible to upgrade all or

specific instruments remotely using GeoDAS. Before trying to upgrade remotely, be sure

the instruments have a working network connection to the server. To proceed with the

firmware upgrade, please take the following steps:

Make a right click on the Station in the GeoDAS main window and select Instrument

Control…

http://www.geosig.com


A list box will appear.

Select the item Send an Upgrade

Press on the button Browse … to select the required firmware. Select a firmware

container with the extension *.gsfw or a *.zip archive containing several update

packages.

If the file is selected, press the Send button. GeoDAS identifies the firmware and asks

for confirmation.

Please double check that the correct firmware has been selected.

Upon pressing the Yes button, the firmware will be placed in the Outgoing directory, so

that it can be collected by the instrument(s) upon next connection.

As soon as the instrument has downloaded the new firmware, the text Pending:

xxx.gsfw disappears. The instrument will verify the firmware and once the upgrade

process is finished, the instrument will restart.

When the instrument software receives such a file it checks the actual version and, only

if the file contains more recent firmware than the existing one, it will start the upgrade.

After the upgrade, the new firmware will be in “trial” mode and a reboot is done. If the

reboot and instrument operation is correct, the new firmware will be accepted. If the

instrument reboots through its watchdog because the firmware was faulty, the previous

firmware version will be used and the system will be restored to its state before the

upgrade.

Downgrades to the older firmware versions might be required in some specific cases.



This is possible, too. Please contact GeoSIG support for the exact procedure of such

downgrade.

Appendix AConnector Pinouts

A.1POWER Connector

A.1.14 pins (V0)

Pin Description Wire color Function

1 GND WHITE Power return for external device

2 DEV_ PWR BROWN External device power supply, 5 or 12 [VDC]

3 EXT_ GND GREEN Power return

4 _ EXT_ SUP+ YELLOW Positive power input, 9 to 48 [VDC]

Mating Type:  Binder 712 Series, cable connector female, 4 pole

A.1.25 pins (V1 and above)

Pin Description Function

1 GND_ OVP Power return for external device

2
EXT_ DEV_ PWR/EXT_ NTC_ OV

P

External device power supply / External N

TC

3 EXT_ GND Power return

4 _ EXT_ SUP+ Positive power input, 9 to 48 [VDC]



5 EXT_ BAT_ SUP_ OVP External battery power supply

Mating Type:      Binder 712 Series, cable connector female, 5 pole

A.2ETHERNET Connector

Pin Description Function

1 N/C Not connected

2 _ ETH_ RX_ P Ethernet receive data +

3 _ ETH_ RX_ N Ethernet receive data –

4 _ ETH_ TX_ P Ethernet transmit data +

5 _ ETH_ TX_ N Ethernet transmit data –

6 _ ETH_ POE_ P Power over Ethernet +

7 _ ETH_ POE_ N Power over Ethernet –

A.3ALARM Connector

A.3.1ela-ALC2

Pin Description Wire Color Function

1 ALARM1(NO) WHITE ALARM1 Normally opened



2 ALARM1(CMN) BROWN ALARM1 Common

3 ALARM2(NO) GREEN ALARM2 Normally opened

4 ALARM2(CMN) YELLOW ALARM2 Common

5 AKN+ GRAY AKNOWLEGDE Signal + /Input Voltage*

6 AKN-/GND PINK AKNOWLEGDE Signal –

7 SUPPLY RED Power Supply*

8 GND BLUE Power Return Path

* In V0, it’s 15 [VDC], in V1 and above it’s 5 [VDC] Mating Type: Binder 712 Series,

cable connector female, 8 pole

 The maximum load is limited at 60VDC and 500mA. Higher voltages or current will

permanently damage the device.

A.3.2ela-ALC3



Pin Description Wire Color Function

1 ALARM1(NO) WHITE ALARM1 Normally opened

2 ALARM2(NO)) BROWN ALARM2 Normally opened

3 ALARM3(NO) GREEN ALARM3 Normally opened

4 ALARMS(CMN) YELLOW ALARMs Common

5 AKN+ GRAY AKNOWLEGDE Signal + /Input Voltage*

6 AKN-/GND PINK AKNOWLEGDE Signal –

7 SUPPLY RED Power Supply*

8 GND BLUE Power Return Path

* In V0, it’s 15 [VDC], in V1 and above it’s 5 [VDC] Mating Type: Binder 712 Series,

cable connector female, 8 pole

 The maximum load is limited at 60VDC and 500mA. Higher voltages or current will

permanently damage the device.

A.4CONSOLE Connector



Pin Description Function

1 CONS_ VB USB Power Supply (VBUS)

2 CONS_ D- USB data –

3 CONS_ D+ USB data +

4 GND USB power return (GND)

5 N/C Not connected

Mating Type: Amphenol LTW Series, cable connector male, 5 pole

Appendix BRemote Access to the Instrument over SSH

 The following chapter is for advanced users only.

Warranty will be void if something is damaged by user during changes in the root file

system.

Secure Shell (SSH) is a network protocol for secure data communication, remote shell

services or command execution and other secure network services between two

networked computers that it connects via a secure channel over an insecure network: a

server and a client (running SSH server and SSH client programs, respectively).

 The armdas console cannot be shown through the SSH. This is a limitation of the

armdas firmware. The instrument supports all types of remote access through SSH.

User can connect from his PC by SSH client program to the SSH server of the

instrument. Simple SSH client program can be used for this purpose. Use root as login

and swiss as the password, as shown:

Login: root

Password: swiss

Sign ‘#’ is a command prompt where you can type console commands.

The password can be changed by passwd command.

 Warranty will be void in case password is changed and forgotten.



B.1SSH Clients for Linux OS

For the Ubuntu or other Debian-like GNU/Linux OS, SSH client program, with command

line interface, can be installed by command

$ sudo apt-get install openssh-client

To login into the instrument console, “ssh root@192.168.1.10” command can be issued

from any terminal emulator as following figure shows:

Alternatively, the PuTTY SSH client with GUI interface can be installed by command

This software can be found in a menu Applications → Internet → PuTTY SSH Client and

its configuration dialog looks like:

IP address 192.168.1.10 from examples above should be changed to the real IP address

of the instrument.

B.2SSH Clients for Windows OS

The same PuTTY as for GNU/Linux OS or alternatively TeraTerm software can be used

for Windows OS to have remote access to the instrument by means of SSH.



Its connection window is shown below

The PuTTY software for Windows OS operates the same as PuTTY for Linux OS.

The PuTTY software can be downloaded from

https://www.chiark.greenend.org.uk/~sgtatham/putty/

The TeraTerm software can be downloaded from http://ttssh2.osdn.jp/

B.3SFTP access for Windows OS

WinSCP is an open source free SFTP client for Windows. Its main function is the easy

file transfer between a local computer and the instrument.

To connect to the instrument put the IP address of the GMSela and enter the following

user name and password:

Login: root

Password: swiss

https://www.chiark.greenend.org.uk/~sgtatham/putty/
http://ttssh2.osdn.jp/


It is then possible to browse through the available data on the instrument and copy files

from or to the computer.

The file structure is described in the following chapter.

The WinSCP can be downloaded from here:https://winscp.net/eng/download.php

B.4File Structure of the Instrument

On the instrument the files are organized as following

The filenames contain the following information

XXX_SNSNSN_YYYYMMDD_HHMMSS.ext

\media\mmcblk01\… in case an SD card is installed

… Data\ Event files

…Ringbuffers\ Permanent recording files

… Logfiles\ Log files of armdas

The filenames contain the following information

XXX_SNSNSN_YYYYMMDD_HHMMSS.ext

Extension

.ext

.msd

.xml

.txt

.bin

Depending on file type

MiniSEED containing waveform data SOH and PGM in

formation

LOG and ERR files

MMA packets (special for Korean market)

HH Hour

https://winscp.net/eng/download.php


Time MM Minutes

SS Seconds

Date

 YYYY Year

MM Month

DD Day

S/N SNSNSN Six digit serial number of instrument

Type XXX Depending on file type

TRG Event trigger

USR User request

TTT Time table trigger

CAL File with test pulse

MAN Manual trigger

RBF Permanent recording

LOG Log files

SOH State of Health information

PGM PGM information of event

ERR Error messages

Appendix C GeoDAS Settings

C.1Configuration of Stations

To be able to communicate with the instrument, GeoDAS must act as a server. This

chapter should help to find the correct settings.

•Open GeoDAS and Go to the menu Settings → Configure Stations… , the following



window will appear:

Are

a
Topic Description

1
Configured GSR Stat

ions

Details about the configured GSR-xx and GCR-xx statio

ns. Check separate GeoDAS Manual for details.



2 Instrument Stations

Details about the configured instruments. All instrument

s connected to the same network will be listed in grey.

Station name can be changed by a double click on the 

field you want to change.

The column Instrument and Serial Number shows the 

instrument type and its serial number.

The Firmware column shows the firmware version of th

e main data acquisition firmware.

The Public IP shows from where the instrument is conn

ected to the server. In case the instrument is behind a r

outer or firewall, then this IP address will be shown. Net

work settings can be done according to chapter 7. If on

e wants to connect manually to the instrument, then Ge

oDAS will try the address and port listed under Addres

s. The last column in the table is Status, which is

indicated by one or more letters, which are the following

:

•   N – New instrument

•   C – already Configured earlier

•   A – Altered parameters

•   R – actual settings were Received from the

instrument

3 Server Settings For configuration of the Server, see chapter C.2

C.1.1Add a new Instrument

All instruments connected to the same network will be listed in grey. To add one of these

stations into the current configuration do the following:

Select the instrument and make a right click

Click on Add Station to Current Configuration

Press OK



If the instrument is not in the local network and cannot directly be accessed, then press

Add New Station Manually and enter the serial number of the instrument.

C.1.2Remove an Instrument

To remove one of the stations of the current configuration do the following:

Select the instrument and make a right click

Click on Remove Station from Configuration

Press OK

For more details please see GeoDAS Manual.

C.2Configuration of Server Parameters

Press the button Server…, the window below appears:



Group of Controls Description

Network Settings

IP address and port of the server, i.e. computer which G

eo- DAS is running on as well as the network Timeout in 

seconds. If server has several network interfaces but con

nections from in- struments are expected from only one

of them, then its IP ad- dress must be specified. Otherwis

e, leave it zero, which means that GeoDAS accepts inco

ming connection at any interface. The timeout is used to 

decide when to terminate current network con- nection if t

he remote party does not respond within the indicated tim

e interval.



Miscellaneous Options

Network error is declared if an instrument did not comm

unicate with GeoDAS within the indicated period of time. 

Make sure that this parameter is higher that the communi

cation interval set in the instrument as described in chapt

er 9.8

If State-of-health forwarding interval is set to nonzero 

value, then SOH reports are collected within this period

of time and only then are forwarded. You can also

choose not to delete SOH reports after processing. If this

option is selected, all received state of health reports rem

ain in the directory \\Geo- DAS_DATA\StatusFiles \InfoSO

H\

Event Detection

GeoDAS can be instructed to analyse event data files rec

eived from configured instruments to see if they belong to

the same earthquake and to declare an event if it is so. Y

ou need to enable the option Declare and process trigg

ers of seismic network in order to do so.

A network event is declared if at least Minimum number

of sta- tions triggered within the Network time frame. 

Received event files can be converted to Seisan format a

nd stored in Seisan database on the same computer.

Customised Data Process

ing

This is not a standard feature of GeoDAS. Therefore plea

se check the GeoDAS Manual and contact GeoSIG for fu

rther de- tails if you need to use this functionality.

C.3Instrument Control in GeoDAS

By making a right click on the station name in the window Stations: General Information,

several options become available to control and check the instrument. See the figure

below:



C.3.1More Information… (State of Health of the Instrument)

The status of the instruments can be easily checked if the instrument is set up to

transfer periodically the SOH file to the server. (See details about SOH configuration in

chapter8.4and9.8).

Make right click on the Station in the GeoDAS main window and select More

Information… , the following window will appear:

Information Area Description

Status date and time
Before analysing the SOH data always make sure that the SO

H files are current ones by checking the time and date here.

Firmware Here the firmware versions of all components can be viewed.

File and Memory Information about events and available memory



Configuration and Re

starts

Date and time of the last restart, the last configuration change

and the last shutdown are shown. Additionally the reason of t

he last shutdown is indicated.

Miscellaneous

Ambient temperature, measured inside the instrument. Other 

information may appear here, depending on the firmware vers

ion of the instrument.

Errors and Warnings List of all errors and warnings of the instrument

Timing and GPS
Status of the RTC and the related GPS information if a GPS r

eceiver is con- nected and configured

Power Status of the power supply and the battery voltages

C.3.2Instrument Setup…

See chapter9.2.2for details.

C.3.3Cancel Pending Request

The pending requests on the server, as shown in the Figure70, can be canceled by the

user.

C.3.4Instrument Communication Interface

Make a right click on the Station in the GeoDAS main window and select Instrument

Control…; the following window will appear:

Action or command Description

Request a File
Request a file from the instrument (the full path to the fi

le must be specified)



Request Configuration Menu

Options

The instrument uploads the structure of the configurati

on menu and saves the file in \\GeoDAS_DATA\Config\

Stationname.mnu. This file is needed for offline configu

ration of the instrument as described in chapter 9.2.1

Request Network Configurat

ion

The instrument uploads the network settings of the inst

rument and saves the file in \\GeoDAS_DATA\Config\S

tationname.net

Request Recorder Configura

tion

The instrument uploads the configuration of the instru

ment and saves the file in \\GeoDAS_DATA\Config\Sta

tionname.xml. This file is needed for offline

configuration of the instrument as described in chapter 

9.2.1

Request Trim Table

The instrument will upload a SOH file containing the ac

tual values from the RTC trim table. The latest SOH file

can be found under \\GeoDAS_DATA\StatusFiles\InfoS

OH.xml

Reset Error State The instrument will clear all errors and warnings.

Reset Trim Table The instrument will clear the RTC trim table.

Send a Request
Sends a user request to the instrument. For details see

chapter 9.12.1

Send a Script

The instrument will download and execute the attached

script. This function is for advanced users only, as it ca

n seriously damage the instrument if the script is not w

ritten correctly.



Send an Upgrade

The instrument will download the attached file, which c

an be any type of the firmware, namely: Bootloader, R

TC, DSP, main firmware and or the entire Linux image.

For more details about the upgrade of the firmware, se

e chapter 11.

Send Binary Network Config

uration

The instrument will download binary network

configuration file from the server.

Send Network Configuration
The instrument will download the attached manually ad

justed net- work configuration file from the server.

Send Recorder Configuratio

n

The instrument will download the attached manually ad

justed recorder configuration from the server.

C.4Open recorded miniSEED files in GeoDAS

The system is recording miniSEED files (.MSD). For viewing such files, GeoDAS can be

used. As the signal is stored inside the miniSEED file in counts, a scaling factor has to

be applied when opening the data. If an Extended format of MiniSEED files is used (see

the chapter9.9), scaling factors are applied by GeoDAS automatically, and you may skip

the information below.

Open GeoDAS

Open recorded mini-seed file from the menu File → Open…

Event files are stored under: \\GeoDAS_ DATA\Data\STATION_NAME

Ringbuffer files are stored under:
\\GeoDAS_DATA\DataStreams\STATION_NAM

E

Testpulses are stored under: \\GeoDAS_ DATA \Incoming\NNNNNN

•When you open a ‘.MSD’ file with GeoDAS, the following dialog box for scaling factor

appears:



The values Physical unit and Counts per physical unit must be set for correct display

data in GeoSIG software GeoDAS. The values can be calculated as described in

chapterC.4.2.

The user has the possibility to tick “Always use the current parameters ” because the

unit gets send with the miniseed file

Press OK

If instead of the scale prompt you get directly the graph, to get back the prompt each

time you open a miniSEED file, use menu: Analyse → Parameters…→ Parameters of

miniSEED files and press Edit:

Now the dialog box for scaling factor should be seen. Enter the correct values, close and

reopen the file you want to see. You will be prompted again for scale; just press OK as

the scale is now correct.

C.4.1Save predefined Scaling Factors

The scaling factor set under Counts per physical unit is always valid for all channels in

the same miniSEED file.

If the channels have different physical units (e.g. if a six-channel instrument with two

different types of sensors is used) a scaling factor for each channel separately can be

defined.
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To define a scaling factor for a specific channel, enter the full channel name (e.g.

LCAX1) in the filed Channel name and press Add

All channels which are not specifically defined are converted with the scaling factor

saved under Default.

C.4.2Calculation of the Scaling Factors

The scaling factor is the inverse of the LSB value.

See section9.3.3for details about how to calculate the LSB factor.
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